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About ASTRO 25 Infrastructure
Reference Guide
This manual provides an introduction to the ASTRO® 25 system for a repeater site, and includes
procedures for installing and configuring the repeater site.

What Is Covered In This Manual?
This manual contains the following chapters:

• Description on page 23 – This chapter provides a description of the devices uses at an ASTRO®

25 repeater site.

• Theory of Operation on page 67 – This chapter contains an overview of operating configurations
and subsystem configurations of an ASTRO® 25 repeater site.

• Installation on page 73 – This chapter provides installation information of an ASTRO® 25 repeater
site.

• Operation on page 83 – This chapter provides information on operational modes of an ASTRO®

25 repeater site.

• Configuration/Optimization on page 85 – This chapter provides information on configuring an
ASTRO® 25 repeater site.

• Troubleshooting on page 101 – This chapter provides the methodology, suggested tools, and
related references for troubleshooting an ASTRO® 25 repeater site and related links.

• Replacement of a Trunked QUANTAR with a GTR 8000 Base Radio on page 107 – This appendix
provides information on how to replace a Trunked QUANTAR with a G-Series base radio.

Useful Background Information
Motorola Solutions offers various courses designed to assist in learning about the system. For
information, go to http://www.motorolasolutions.com/training to view the current course offerings and
technology paths.

Related Information
See the following documents for associated information about the radio system.

Related Information Purpose

Standards and Guidelines for
Communication Sites

This may be purchased on CD 9880384V83 by calling the
North America Parts Organization at 800–422–4210 (or the
international number: 302–444–9842).

System Overview and Documenta-
tion

Provides an overview of the ASTRO® 25 new system fea-
tures, documentation set, technical illustrations, and system-
level disaster recovery that support the ASTRO® 25 radio
communication system.

Dynamic System Resilience Provides all the information required to understand, operate,
maintain, and troubleshoot the Dynamic System Resilience
feature.

Table continued…
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Related Information Purpose

GTR 8000 Expandable Site Sub-
system
GTR 8000 Base Radio

GCP 8000 Site Controller

S6000 and S2500 System Routers

GGM 8000 System Gateway

System LAN Switches

Simulcast Site Reference (TRAK)

QUANTAR Instruction Manual
(6881095E05)

Provides the information required to understand and operate
the devices in an ASTRO® 25 repeater site.

GGM 8000 Hardware User Guide
S2500 Hardware User Guide

S6000 Hardware User Guide

Available on the Motorola Online website https://businesson-
line.motorolasolutions.com. To access the manual, select
Resource Center � Production Information � Manuals � Network
Infrastructure � Routers and Gateway.
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Chapter 1

Description
This chapter provides a high-level description of an ASTRO® 25 repeater site and the devices within
the system.

1.1

Introduction – GTR 8000 Expandable Site Subsystem
An ASTRO® 25 system repeater site with a GTR 8000 Expandable Site Subsystem is a single-solution,
RF communication site designed to optimize channel capacity requirements operating in the 700/800
MHz, 900 MHz, UHF R1 (380–435 MHz), UHF R2 (435–524 MHz), and VHF (136–174 MHz) bands
and supporting 28 channels.

The GTR 8000 Expandable Site Subsystem in a repeater site is set up in a single trunked site, with
one active control channel and a number of voice channels at the site. If packet data services are
supported at the site, a number of voice channels can be configured with packet data channel
capability. Voice traffic is routed from each of the base radios to the system for distribution to other
sites and is repeated by the base radios to support other local subscribers. However, data traffic is
routed to the GCP 8000 Site Controller. The site controller routes these packets upstream to the zone
core or the zone controller in a Trunking Subsystem (Tsub) for further processing and routing.

The GTR 8000 Expandable Site Subsystem is an integrated open rack or cabinet that consist of GTR
8000 Base Radios (transceiver module, power amplifier module, fan module, and power supply module
for each transmission channel).

The GTR 8000 Expandable Site Subsystem may also contain GCP 8000 Site Controller modules,
XHub modules, GGM 8000 Gateways, and optional RFDS equipment. This configuration provides a
major advantage in terms of reduced site cabling and costs. All the required connections between the
base radios, site controllers, and XHubs, are contained in the backplane; whereas individual units
mounted in a 19-inch rack or cabinet require external cabling. Also, the site controller, XHub, or
gateways in a GTR 8000 Expandable Site Subsystem do not have a power supply of their own, but
draw power from the base radio power supply modules.

Each GTR 8000 Expandable Site Subsystem cabinet contains a maximum of six base radios.
Additional GTR 8000 Expandable Site Subsystem racks or cabinets can be added to increase the
number of channels at a site. The base radios transceiver module includes the functionality for the
exciter, receiver, and station control with an optional transceiver option card. The base radio software,
configuration, and network management, as well as inbound/outbound traffic handling, are performed
through the control section of the base radios transceiver module. On-board serial and Ethernet ports
are on the transceiver module for local servicing through Configuration/Service Software (CSS) and the
Unified Network Configurator (UNC). The power amplifier module amplifies the low-level modulated RF
signal from the transceiver module and delivers the amplified signal on the path to the transmit
antenna. The power supply module supports the transceiver and power amplifier modules. Radio
Frequency Distribution System (RFDS) provides the interface between the transceivers and the site
antennas and between the power amplifier and the site antennas. Each transceiver has an Ethernet
connection to the site controller, and XHub modules.

Voice channels, data channels, or control channels can be enabled for each base radio. Channels one
through four can be designated as control channels per site. The base radio operates as a Compatible
4-level Frequency Modulation (C4FM) or Linear Simulcast Modulation (LSM) Transmitter/Receiver in
the 700/800 MHz, 900 MHz, UHF R1 (380–435 MHz), UHF R2 (435–524 MHz), and VHF (136–174
MHz) bands. For Phase 2 TDMA, the base radio operates as a Harmonized-Differential Quadrature
Phase Shift Keyed Modulation (H-DQPSK) Transmitter/Receiver in the 700/800 MHz, UHF R1 (380–
435 MHz), UHF R2 (435–524 MHz), and VHF (136–174 MHz) bands. Throughout this manual, the
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term “base radio” is used to denote the transceiver and associated modules providing the functionality
for one channel. As viewed in this application, one “base radio” is one of several “channels” in a GTR
8000 Expandable Site Subsystem configuration.

For more information on the GTR 8000 Expandable Site Subsystem configurations, specifications,
theory of operation, installation, and connection tables see the GTR 8000 Expandable Site Subsystem
manual.

NOTICE: RFDS information provided in this documentation pertains to the RFDS equipment
included in the GTR 8000 Expandable Site Subsystem.

1.1.1

GTR 8000 Expandable Site Subsystem for ASTRO 25 Repeater

The GTR 8000 Expandable Site Subsystem is an integrated cabinet or open rack with site controllers,
channel equipment, and RFDS equipment available for most frequency bands. Figure 1: GTR 8000
Expandable Site Subsystem for Repeater Site Module Configuration on page 24 shows an example
of the RFDS equipment configured for a one branch RMC.

Figure 1: GTR 8000 Expandable Site Subsystem for Repeater Site Module Configuration

For repeater site operation, the cabinet/rack includes the following components:

• Redundant site controller modules (integrated in the cabinet/rack or standalone)

• Up to six trunked transceiver modules
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• Up to four conventional transceiver modules

• Up to six power amplifier modules

• Up to six power supply modules

• RFDS equipment for the transmit (Tx) and receive (Rx) paths

• GGM 8000 Gateways (optional)

• Junction panel, for connection to other devices at the site, such as site gateway(s), Rx and Tx
antennas, and SDM RTU.

The site controller modules, transceiver modules, and power amplifier modules are arranged in the
slots of the cabinet/rack as illustrated in the diagram. Each transceiver, power amplifier, and power
supply represents a channel in the subsystem. The GTR 8000 Expandable Site Subsystem supports
up to 28 channels. Therefore, a maximum of six transceivers, power amplifiers, and power supplies
may be installed in the cabinet/rack with a maximum of six cabinets/racks. Any expansion cabinets/
racks attached to the primary cabinet/rack use XHubs instead of site controllers.

The site controllers in an ASTRO® 25 repeater site can also support a mix of GTR 8000 Expandable
Site Subsystem cabinets/racks and standalone 10Base-T Ethernet Epic IV or Epic VI QUANTAR®

stations. The site controllers can be either integrated into the rack/cabinet or in a standalone
configuration outside the rack/cabinet. Possible configurations can be either:

• GCP 8000 Site Controllers integrated into the primary cabinet/rack with additional expansion racks/
cabinets containing XHubs, with or without QUANTAR® stations.

• Standalone GCP 8000 Site Controllers outside the primary rack/cabinet containing XHubs, with or
without QUANTAR® stations.

The active site controller module communicates with the channels and sends status messages over
the backplane of the GTR 8000 Expandable Site Subsystem chassis. The standby site controller
module passively monitors status messages on the backplane to determine whether the active site
controller is still operational.

The GTR 8000 Expandable Site Subsystem can be ordered in a cabinet (Option CA00293AA) or 7.5 ft
open rack (Option X882AH) or 7 ft open rack (Option CA01402AA).

The Site RMC (LNA) module displayed in the upper half of Figure 1: GTR 8000 Expandable Site
Subsystem for Repeater Site Module Configuration on page 24 may not be present in your installation,
depending on the options purchased from Motorola Solutions.

The following options are only valid for 700/800/900 MHz and UHF R2 (435–524 MHz):

• Option CA00862AA includes the one Site RMC module, which provides expansion of up to 24
channels on a single Rx antenna.

• Option CA00861AA does not include Site RMCs. It provides basic RMC functionality that is limited
to a single cabinet or rack.

• Option CA00877AA does not include Site RMCs. It is intended for use in expansion cabinets that
are wired to the primary Rx cabinet through the junction panel, and in other configurations using
RMC equipment outside the cabinet.

• Option CA01943AA includes two Site RMC modules for Phase 2 TDMA operation, dual branch
receive diversity. See “Appendix B” in the Dynamic Dual Mode for TDMA Operation Feature Guide
manual.

1.1.1.1

GTR 8000 Expandable Site Subsystem RFDS Transmit Path

The transmit part of the RFDS includes the following equipment:
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• Combiner: Includes an isolator at each input port (700/800 MHz and UHF R2 435–524 MHz)

• Transmit filter: (700/800/900 MHz and UHF R2 435–524 MHz)

• Power Monitor Unit (PMU): (900 MHz, VHF 136–174 MHz, UHF R1 380–435 MHz, and UHF R2
435–524 MHz)

NOTICE: The Power Monitor Unit (PMU) is not supported and is reserved for future use.

The combiner aggregates all the transmit signals to a common line for the transmit antenna. It includes
integrated isolators to protect the base radios from reflected signaling and to improve intermodulation
performance. The transmit filter removes any remaining noise in the receive sub-band. It includes a
power monitor to measure forward and reverse power on the transmit line. The output is sent to the
transmit antenna port.

If 700/800 MHz channels are in a dual band configuration at the site in different cabinets, then a
diplexer is used in place of the Transmit filter.

Figure 2: GTR 8000 Expandable Site Subsystem for Trunked Repeater Site Transmit Path

1.1.1.2

GTR 8000 Expandable Site Subsystem RFDS Receive Path

The receive part of the RFDS includes the following equipment for 700/800/900 MHz and UHF R2
(435–524 MHz):

• Cabinet Receive Multicouplers/low noise amplifiers (Cabinet RMC in Figure 3: GTR 8000
Expandable Site Subsystem for Trunked Repeater Site Receive Path (700/800/900 MHz/UHF
R2) on page 27): Provide a low noise amplifier with a 6-way splitter that is used to distribute
inbound signaling to the individual base radios over the backplane to complete the receive path.
Two Cabinet RMC modules are used for Phase 2 TDMA operation, dual branch receive diversity.
See “Appendix B” in the manual.

• Dynamic Dual Mode for TDMA Operation Feature Guide

• Site Preselector: Provides signal filtering for the inbound signal. The RF input and output
connectors on the front of the device are connected to the junction panel and a receive
multicoupler. An input port for injecting test signals is also provided.
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• Site Receive Multicouplers/Low Noise Amplifiers (Site RMC in Figure 3: GTR 8000
Expandable Site Subsystem for Trunked Repeater Site Receive Path (700/800/900 MHz/UHF
R2) on page 27): If option CA00862AA is purchased, each receive path includes a receive
multicoupler/low noise amplifier (RMC/LNA) with a balanced amplifier and a 4-way splitter that can
be used to distribute inbound signaling to multiple expansion racks. The RF input and output
connectors on the front of the device are connected to the preselector, junction panel, and the
cabinet RMC/LNA. If Option CA01943AA is purchased, it includes two Site RMC modules for Phase
2 TDMA operation, dual branch receive diversity. See “Appendix B” in the Dynamic Dual Mode for
TDMA Operation Feature Guide manual.

System connections are made through the junction panel on the top of the rack. This panel includes
the inputs for RF antennas and outputs for expansion cabinets.

The following diagram illustrates the inbound path for the GTR 8000 Expandable Site Subsystem.
Tower Top Amplifiers (TTAs) would be present only if supplied by your organization.

Figure 3: GTR 8000 Expandable Site Subsystem for Trunked Repeater Site Receive Path
(700/800/900 MHz/UHF R2)

The receive part of the RFDS includes the following equipment for VHF (136–174 MHz) or UHF R1
(380–435 MHz):

• RMC Pass Through Module (in Figure 4: GTR 8000 Expandable Site Subsystem for Trunked
Repeater Site Inbound Receive Path (VHF or UHF R1) on page 28): For VHF or UHF R1, the
receive path always includes an RMC Thru module. The Six RF input connectors on the front of the
device are connected to the junction panel. This module routes the RX signals to the backplane for
distribution to the six base radios. There are no active components, splitters, or combiners on this
module.
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Figure 4: GTR 8000 Expandable Site Subsystem for Trunked Repeater Site Inbound Receive
Path (VHF or UHF R1)

1.1.1.3

ASTRO 25 Repeater Site Subsystem Configurations (700/800/900 MHz)
ASTRO® 25 Repeater Site supported configurations for the GTR 8000 Expandable Site Subsystem
include:

• ASTRO® 25 Repeater Site Single site router or gateway, dual Ethernet switch for subsystems with
up to 28 base radios (see ASTRO 25 Repeater Single Link, Dual Switch Subsystem (700/800/900
MHz) on page 28) .

• ASTRO® 25 Repeater Site Dual site router or gateway, dual Ethernet switch for subsystems with up
to 28 base radios (see ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem
(700/800/900 MHz) on page 30) .

• ASTRO® 25 Repeater Site Dual band (700 MHz and 800 MHz) (see ASTRO 25 Repeater Dual
Band Subsystem (700/800 MHz) on page 31) .

• ASTRO® 25 Repeater Site with HPD Overlay (see ASTRO 25 Repeater Site with HPD Overlay
(700/800 MHz) on page 46) .

NOTICE: In a GTR 8000 Expandable Site Subsystem, the Ethernet switch is integrated in the
site controller.

The specific configuration installed in a system depends on your organization requirements and
transport resources.

1.1.1.3.1
ASTRO 25 Repeater Single Link, Dual Switch Subsystem (700/800/900 MHz)
The following diagram illustrates one of the possible configurations for an ASTRO® 25 system repeater
site with a GTR 8000 Expandable Site Subsystem and supports 28 base radios.
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Figure 5: Single Link, Dual Ethernet Switch ASTRO 25 System Repeater Site with a GTR 8000
Expandable Site Subsystem for 700/800/900 MHz

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

An interface between the two Ethernet switches provides access to all the base radios by either site
controller. The interface also makes it possible for any base station to be able to route its traffic to the
one or two site routers or gateways.

Minimum requirements for wide area operation include:

• A site controller

• A site router or gateway

• Connectivity from the site router or site gateway through one or both Ethernet switches (integrated
with the site controllers) to the voice and control channel

• One voice channel

• One control channel

• A physical link between the subsystem and the zone core or zone controller in a (Tsub)

• A logical path between the site router or site gateway and the zone core or (Tsub) IP equipment

Failure of a single site router or gateway causes failure of both zone controller or (Tsub) and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
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supported are transmission trunked and terminated. Radio users are minimally impacted due to the
switchover of call processing from the zone controller or (Tsub) to one of the site controllers.

If a single site controller fails, the site continues to operate as normal and existing calls are not
affected. If both site controllers fail, then the site enters the Failsoft mode.

1.1.1.3.2
ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem (700/800/900
MHz)
The dual site router or gateway and dual Ethernet switch configuration provides the highest level of
redundancy to the subsystem. If one of the two routers fails or one of the links to the zone core or zone
controller (Tsub) through these routers fails, the site remains in wide area trunking mode.

Two Ethernet switches are embedded in the site controllers used in an ASTRO® 25 system repeater
site with a GTR 8000 Expandable Site Subsystem.

Figure 6: Dual Link, Dual Switch ASTRO 25 System Repeater Site Expandable Site Subsystem
for 700/800/900 MHz

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 is used for one site link and Ethernet is used for the other
site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links manual.
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1.1.1.3.3
ASTRO 25 Repeater Dual Band Subsystem (700/800 MHz)
An example of one possible configuration of a GTR 8000 Expandable Site Subsystem with dual band
is shown in the following diagram.

Figure 7: Dual Band Subsystem for 700/800 MHz

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to thezone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 is used for one site link and Ethernet is used for the other
site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links manual.

Dual band operation requires one transmit path and one receive path. A diplexer is used only if side-
by-side cabinets have two different bands. It is not needed if the site has a pair of 700 MHz cabinets
side by side or a pair of 800 MHz cabinets side by side. Many variations are possible including
configurations with more base radios and cabinets than shown in this example.

In the example, the line between cabinets represents a diplexer extension cable.

1.1.1.4

ASTRO 25 Repeater Subsystem Configurations for UHF R1 (380–435
MHz)
Supported configurations for a GTR 8000 Expandable Site Subsystem include:

• ASTRO® 25 Repeater Site Single site router or gateway, dual Ethernet switch for subsystems with
up to 28 base radios (see ASTRO 25 Repeater Single Link, Dual Switch Subsystem UHF R1 (380–
435 MHz) on page 32).
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• ASTRO® 25 Repeater Site Dual site router or gateway, dual Ethernet switch for subsystems with up
to 28 base radios (see ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem UHF R1
(380–450 MHz) on page 33).

• ASTRO® 25 Repeater Site Repeater site with HPD overlay (see ASTRO 25 Repeater Site with HPD
Overlay UHF R1 (380–450 MHz) on page 48).

NOTICE: In an ASTRO® 25 system for a repeater site with GTR 8000 Expandable Site
Subsystem, the Ethernet switch is integrated in the site controller. The specific configuration
installed in a system depends on your organization requirements and transport resources.

1.1.1.4.1
ASTRO 25 Repeater Single Link, Dual Switch Subsystem UHF R1 (380–435 MHz)
The following diagram illustrates one of the possible configurations for an ASTRO® 25 system for a
repeater site with a GTR 8000 Expandable Site Subsystem and supports 28 base radios.

Figure 8: Single Link, Dual Ethernet Switch ASTRO 25 System Repeater Site with a GTR 8000
Expandable Site Subsystem for UHF R1 (380–435 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).
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An interface between the two Ethernet switches provides access to all the base radios by either site
controller. The interface also makes it possible for any base station to be able to route its traffic to the
site router or site gateway.

Failure of a single site router or gateway causes failure of both zone controller and RF site controller
paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being supported
are transmission trunked and terminated. Radio users are minimally impacted due to the switchover of
call processing from the zone controller to one of the site controllers.

If a single site controller fails, the site continues to operate as normal and existing calls are not
affected. If both site controllers fail, then the site enters the Failsoft mode.

1.1.1.4.2
ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem UHF R1 (380–
450 MHz)
The dual site router or gateway and dual Ethernet switch configuration provides the highest level of
redundancy to the subsystem. Failure of a single site router or gateway, or one of the physical links to
the zone core or zone controller in a Trunking Subsystem (Tsub) is dropped, a site that was in Wide
Area Trunking mode remains in Wide Area Trunking mode of operation.

The dual site router or gateway link to the zone core or (Tsub) provides path diversity for the RF site
link. It requires two Ethernet switches (embedded in the site controllers) at the GTR 8000 Expandable
Site Subsystem.
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Figure 9: Dual Link, Dual Switch ASTRO 25 System Repeater Site Expandable Site Subsystem
for UHF R1 (380–435 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 is used for one site link and Ethernet is used for the other
site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links manual.

1.1.1.5

ASTRO 25 Repeater Subsystem Configurations for UHF R2 (435–524
MHz)
Supported configurations for a GTR 8000 Expandable Site Subsystem include:

• ASTRO® 25 Repeater Site Single site router or gateway, dual Ethernet switch for subsystems with
up to 28 base radios (see ASTRO 25 Repeater Single Link, Dual Switch Subsystem UHF R2 (435–
524 MHz) on page 35).
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• ASTRO® 25 Repeater Site Dual site router or gateway, dual Ethernet switch for subsystems with up
to 28 base radios (see ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem UHF R2
(435–524 MHz) on page 36).

• ASTRO® 25 Repeater Site Repeater site with HPD overlay (see ASTRO 25 Repeater Site with HPD
Overlay UHF R2 (435–524 MHz) on page 49).

NOTICE: In a GTR 8000 Expandable Site Subsystem, the Ethernet switch is integrated in the
site controller.

The specific configuration installed in a system depends on your organization requirements and
transport resources.

1.1.1.5.1
ASTRO 25 Repeater Single Link, Dual Switch Subsystem UHF R2 (435–524 MHz)
The following diagram illustrates one of the possible configurations for an ASTRO® 25 system for a
repeater site with a GTR 8000 Expandable Site Subsystem. This particular configuration supports 28
base radios.

Figure 10: Single Link, Dual Ethernet Switch ASTRO 25 System Repeater Site with a GTR 8000
Expandable Site Subsystem for UHF R2 (435–524 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).
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An interface between the two Ethernet switches provides access to all the base radios by either site
controller. The interface also makes it possible for any base station to be able to route its traffic to the
site router or gateway.

Failure of a single site router or gateway causes failure of both zone controller and RF site controller
paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being supported
are transmission trunked and terminated. Radio users are minimally impacted due to the switchover of
call processing from the zone controller to one of the site controllers.

If a single site controller fails, the site continues to operate as normal and existing calls are not
affected. If both site controllers fail, then the site enters the Failsoft mode.

1.1.1.5.2
ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem UHF R2 (435–
524 MHz)
The dual site router or gateway and dual Ethernet switch configuration provides the highest level of
redundancy to the subsystem. Failure of a single site router or gateway, or one of the physical links to
the zone core or zone controller in a Trunking Subsystem (Tsub) is dropped, a site that was in Wide
Area Trunking mode remains in Wide Area Trunking mode of operation.

The dual site router or gateway link to the zone core or (Tsub) provides path diversity for the RF site
link. It requires two Ethernet switches (embedded in the site controllers) at the GTR 8000 Expandable
Site Subsystem.
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Figure 11: Dual Router, Dual Switch ASTRO 25 System Repeater Site Expandable Site
Subsystem for UHF R2 (435–524 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 is used for one site link and Ethernet is used for the other
site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links manual.

1.1.1.6

ASTRO 25 Repeater Subsystem Configurations for VHF (136–174 MHz)
Supported configurations for a GTR 8000 Expandable Site Subsystem include:

• ASTRO® 25 Repeater Site Single site router or gateway, dual Ethernet switch for subsystems with
up to 28 base radios (see ASTRO 25 Repeater Single Link, Dual Switch Subsystem VHF (136–174
MHz) on page 38).

• ASTRO® 25 Repeater Site Dual router or gateway, dual Ethernet switch for subsystems with up to
28 base radios (see ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem VHF (136–
174 MHz) on page 39).

• ASTRO® 25 Repeater Site Repeater site with HPD overlay (see ASTRO 25 Repeater Site with HPD
Overlay VHF (136–174 MHz) on page 51).
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NOTICE: In a GTR 8000 Expandable Site Subsystem, the Ethernet switch is integrated in the
site controller.

The specific configuration installed in a system depends on your organization requirements and
transport resources.

1.1.1.6.1
ASTRO 25 Repeater Single Link, Dual Switch Subsystem VHF (136–174 MHz)
The following diagram illustrates one of the possible configurations for an ASTRO® 25 system for a
repeater site with a GTR 8000 Expandable Site Subsystem and this configuration supports 28 base
radios.

Figure 12: Single Link, Dual Ethernet Switch ASTRO 25 System Repeater Site with a GTR 8000
Expandable Site Subsystem for VHF (136–174 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).
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An interface between the two Ethernet switches provides access to all the base radios by either
controller. The interface also makes it possible for any base station to be able to route its traffic to the
site router or gateway.

Failure of a single site router or gateway causes failure of both zone controller and RF site controller
paths and, in turn, forces the site into Site Trunking mode. All existing calls being supported are
transmission trunked and terminated. Radio users are minimally impacted due to the switchover of call
processing from the zone controller to one of the site controllers.

If a single site controller fails, the site continues to operate as normal and existing calls are not
affected. If both site controllers fail, then the site enters the Failsoft mode.

1.1.1.6.2
ASTRO 25 Repeater Dual Link, Dual Ethernet Switch Subsystem VHF (136–174
MHz)
The dual site router or gateway and dual Ethernet switch configuration provides the highest level of
redundancy to the subsystem. Failure of a single site router or gateway, or one of the physical links to
the zone core or zone controller in a Trunking Subsystem (Tsub) is dropped, a site that was in Wide
Area Trunking mode remains in Wide Area Trunking mode of operation.

The dual site router or gateway link to the zone core or (Tsub) yields path diversity for the RF site link.
It requires two Ethernet switches (embedded in the site controllers) at the GTR 8000 Expandable Site
Subsystem.
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Figure 13: Dual Link, Dual Switch ASTRO 25 System Repeater Site Expandable Site Subsystem
for VHF (136–174 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 is used for one site link and Ethernet is used for the other
site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links manual.

1.1.1.7

ASTRO 25 Repeater Site Subsystem with External Standalone GCP 8000
Site Controller
The GTR 8000 Expandable Site Subsystem cabinet/rack contains two XHub modules with a maximum
of six GTR 8000 Base Radios. Additional GTR 8000 Base Radios are contained in expansion racks/
cabinets containing XHubs. The GCP 8000 Site Controller is in a standalone configuration outside the
cabinet/rack and is comprised of one chassis that holds two site controller modules that have
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embedded LAN switches. The site controller connections are made to the junction panels of each GTR
8000 Expandable Site Subsystem cabinet/rack. See the “Junction Panel Connections” section in the
GTR 8000 Expandable Site Subsystem manual for connection details.

Figure 14: GTR 8000 Expandable Site Subsystem with an External Standalone GCP 8000 Site
Controller
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Traffic is routed using single site router or gateway or dual site router or gateway configuration. Failure
of a single site router or gateway configuration causes failure of both zone controller and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
supported are transmission trunked and terminated. The dual site router or gateway configuration
provides the highest level of redundancy to the subsystem. If one of the two routers fails or one of the
links to the zone core or zone controller in a Trunking Subsystem (Tsub) through these routers fails,
the site remains in wide area trunking mode.

The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

1.2

Introduction – Standalone GTR 8000 Base Radio
An ASTRO® 25 system repeater site with standalone GTR 8000 Base Radios is set up in a single
trunked site, with one active control channel and a number of voice channels at the site operating in
the 700/800 MHz, UHF R1 (380–435 MHz), UHF R2 (435–524 MHz), and VHF (136–174 MHz) bands
and supporting 28 channels. If packet data services are supported at the site, a number of voice
channels can be configured with packet data channel capability. Voice traffic is routed from each of the
base radios to the system for distribution to other sites and is repeated by the base radios to support
other local subscribers. However, data traffic is routed to a site controller. The site controller routes
these packets upstream to the zone core or zone controller in a Trunking Subsystem (Tsub) for further
processing and routing.
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A standalone GTR 8000 Base Radio consists of a transceiver module, power amplifier module, fan
module, and power supply. The transceiver module includes the functionality for the exciter, receiver,
and station control with an optional transceiver option card. The base radio software, configuration, and
network management, as well as inbound/outbound traffic handling, are performed through the
transceiver module. On-board serial and Ethernet service ports are on the transceiver module for local
servicing through CSS and the Unified Network Configurator (UNC). Each transceiver has an Ethernet
connection to a standalone GCP 8000 Site Controller. The power amplifier module amplifies the low-
level modulated RF signal from the transceiver module and delivers the amplified signal on the path to
the transmit antenna. The power supply module supports the transceiver and power amplifier modules.
Radio Frequency Distribution System (RFDS) provides the interface between the transceivers and the
site antennas and between the power amplifier and the site antennas.

Voice, data, and control channel capability can be enabled for each GTR 8000 Base Radio. Up to four
base radios per site can be designated as control channels. The base radio operates as a Compatible
4-level Frequency Modulation (C4FM) or Linear Simulcast Modulation (LSM) Transmitter/Receiver. For
Phase 2 TDMA, the base radio operates as a Harmonized-Differential Quadrature Phase Shift Keyed
Modulation (H-DQPSK) Transmitter/Receiver.

An ASTRO® 25 repeater site that employs standalone GTR 8000 Base Radios can have an additional
five HPD channels added to the site in an HPD overlay configuration. The HPD overlay configuration
can consist of a standalone HPD GCP 8000 Site Controller, standalone HPD GTR 8000 Base Radio,
GTR 8000 Site Subsystem, or HPD GTR 8000 Expandable Site Subsystem. The HPD overlay
equipment shares the network medium to the zone core or (Tsub) through one or two Ethernet
connections on the site LAN. Connections from the HPD site controller to the site LAN may be to the
external Ethernet LAN switches or to the integrated LAN switches within the site controllers.

TDMA operation is supported at an ASTRO® 25 repeater site with standalone GTR 8000 Base Radios,
including Dynamic Dual Mode for the GTR 8000 Base Radios operating in either FDMA mode or
Phase 2 TDMA mode. GTR 8000 Base Radios operating in TDMA mode support Enhanced Data.

An ASTRO® 25 repeater site with standalone GTR 8000 Base Radios supports Dynamic System
Resilience (DSR) functionality. DSR capability is established by configuring a separate physical path to
the backup zone core. The repeater site can switch over if the entire primary zone core fails and
remains in Wide Area Trunking mode.

The standalone GCP 8000 Site Controller is comprised of one chassis that holds two site controller
modules that have embedded LAN switches which are used to communicate with the standalone GTR
8000 Base Radios.

The following system configurations are supported at an ASTRO® 25 repeater site with standalone
GTR 8000 Base Radios:

• Standalone GCP 8000 Site Controllers controlling six or less standalone GTR 8000 Base Radios

• Standalone GCP 8000 Site Controllers controlling more than six standalone GTR 8000 Base
Radios (External Reference Only)

• Standalone GCP 8000 Site Controllers controlling more than six standalone GTR 8000 Base
Radios (GCP 8000 Site Controller and External Reference)

For more information on the configurations, specifications, theory of operation, RFDS equipment, and
installation and connections see the following manuals:

• GTR 8000 Base Radio

• GCP 8000 Site Controller

• System LAN Switches

• GGM 8000 System Gateway

• S2500 and S2600 System Routers

• Simulcast Site Reference (TRAK)
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Standalone GCP 8000 Site Controllers with Six or Less GTR 8000 Base Radios
The base radio transceiver generates the station reference, which typically must be locked onto the
site controller TDM clocks for time and frequency reference.

An interface between the two integrated Ethernet switches provides access to all the base radios by
both site controllers. The interface also makes it possible for any base radio to route its traffic to the
site router or site gateway.

Figure 15: Standalone GCP 8000 Site Controllers with Six or Less GTR 8000 Base Radios
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Traffic is routed using single or dual routers or gateways. Failure of a single site router or gateway
configuration causes failure of both zone controller and RF site controller paths and, in turn, forces the
site into Site Trunking mode. All existing calls that are being supported are transmission trunked and
terminated. The dual site router or gateway configuration provides the highest level of redundancy to
the subsystem. The site remains in wide area trunking mode if one of the two routers fails. If a single
site controller fails, the site continues to operate as normal and existing calls are not affected. If both
site controllers fail, then the site enters the Failsoft mode.

Standalone GCP 8000 Site Controllers with More than Six GTR 8000 Base
Radios (External Reference Only)
External LAN switches connect directly to the base radios and site controllers. The TRAK 9100 or
TRAK 8835 provides 5 MHz frequency reference to the base radios. For a site with TDMA or
Enhanced Data, the TRAK provides composite 5 MHz + 1PPS signal sourcing to the base radios, and
1PPS time reference to the GCP 8000 Site Controllers.

NOTICE: The TRAK 9100 must be used when more than eight base radios that require external
references are at the site.
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Figure 16: Standalone GCP 8000 Site Controllers with More than Six GTR 8000 Base Radios –
External Reference Only
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Traffic is routed using single site router or gateway and single LAN switch; single site router or gateway
and dual LAN switches; or dual site routers or gateways and dual LAN switches. Failure of a single site
router, gateway, or single LAN switch configuration causes failure of both zone controller and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
supported are transmission trunked and terminated. The dual site router or gateway and dual LAN
switch configuration provides the highest level of redundancy to the subsystem. If one of the two
routers fails or one of the links to the zone core or (Tsub) through these routers fail, the site remains in
wide area trunking mode. If one of the two LAN switches fails, the base radios connected to that switch
go into Failsoft mode.

NOTICE: In a dual LAN switch configuration, both site controllers are connected to their
respective LAN switches. To prevent a switched network loop, there is no Ethernet link between
the two LAN switches.

If a single site controller fails, the site continues to operate as normal and existing calls are not
affected. If both site controllers fail, then the site enters Failsoft mode.

NOTICE: A Dual LAN switch configuration is required with more than 18 channels.

Standalone GCP 8000 Site Controllers with Six or More Standalone GTR 8000
Base Radios (GCP 8000 Site Controller and External Reference)
Base radios one through six connect directly to the site controllers to provide dual LAN time and
frequency reference capabilities. The base radio transceiver generates the station reference, which
typically must be locked onto the site controller TDM clocks for time and frequency reference. Base
radios seven through 28 connect to an external Ethernet LAN switch and a TRAK 8835 or TRAK 9100
to provide a 5 MHz time and frequency reference to the base radios. This configuration also provides
improved time and frequency reference by leveraging both the site controller and TRAK device as
reference sources. For a site with TDMA or Enhanced Data, the TRAK provides composite 5 MHz +
1PPS signal sourcing to the base radios, and 1PPS time reference to the GCP 8000 Site Controllers.

This configuration provides additional redundancy at the site in the case of a TRAK failure. Failure of
the TRAK device causes failure of channels seven through 28. Channels one through six are not
affected.
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Traffic is routed using single site router or gateway and single LAN switch; or dual site routers or
gateways and single LAN switches. Failure of a single site router or gateway causes failure of both
zone controller and RF site controller paths and, in turn, forces the site into Site Trunking mode. All
existing calls that are being supported are transmission trunked and terminated. The dual site router or
gateway configuration provides the highest level of redundancy to the subsystem. If one of the two
routers fails or one of the links to the zone core or (Tub) through these routers fail, the site remains in
wide area trunking mode.

NOTICE: A single TRAK 8835 supports up to eight standalone base radios that require external
references. When more than eight base radios are at the site that require external references,
use a TRAK 9100 or multiple TRAK 8835 devices.
This configuration does not support TDMA operation.

Figure 17: Standalone GCP 8000 Site Controllers with Six or More Standalone GTR 8000 Base
Radios – GCP 8000 Site Controller and External Reference
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1.3

ASTRO 25 Repeater Site with HPD Overlay
HPD remote site equipment can be added to a new or existing ASTRO® 25 repeater site. It provides
HPD services to 700/800 MHz mobile subscriber units in the coverage area. The HPD overlay
equipment at the site shares the network transport path (switch, router, and site link) as the IV&D
equipment at the site. However, the HPD overlay equipment operates separately from the IV&D
equipment. Having its own HPD GCP 8000 Site Controller, HPD GTR 8000 Base Radios, and
MOSCAD Network Fault Management (NFM) monitoring platform, the HPD overlay equipment does
not interact with the IV&D equipment at the ASTRO® 25 repeater site. The HPD overlay equipment
shares the network medium to the master site through one or two Ethernet connections on the
ASTRO® 25 repeater site LAN.

HPD overlay at a site operates in the same fashion as a standalone HPD site to provide an RF
interface to mobile subscriber units in the region. The HPD overlay equipment includes a site controller
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with redundant modules to service registration requests, administer site operations, and handle
inbound/outbound HPD traffic.

The site may include up to five HPD channels. Each channel at the site is a full-duplex GTR 8000 Base
Radio with HPD capability.

Alarms and RFDS fault management for the HPD equipment can be handled through the MOSCAD
NFM equipment that is supporting the remainder of the IV&D equipment at the site.

The HPD overlay equipment at the ASTRO® 25 repeater site may consist of the following platforms:

• HPD GCP 8000 Site Controller, standalone (with redundant modules)

• HPD GTR 8000 Base Radios, standalone (for 700 MHz and 800 MHz HPD channels)

• HPD GTR 8000 Site Subsystem

• HPD GTR 8000 Expandable Site Subsystem

For more information on the configurations, specifications, theory of operation, RFDS equipment, and
installation and connections see the following manuals:

• GTR 8000 Base Radio

• GTR 8000 Expandable Site Subsystem

• HPD – GTR 8000 Site Subsystem

• GCP 8000 Site Controller

• System LAN Switches

• GGM 8000 System Gateway

• S2500 and S2600 System Routers

• Simulcast Site Reference (TRAK)

1.3.1

ASTRO 25 Repeater Site with HPD Overlay (700/800 MHz)
An example of an ASTRO® 25 repeater site with HPD overlay is shown in the following diagram.
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Figure 18: Example of Repeater Site with HPD Overlay for 700/800 MHz

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the Zone Core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 can be used for one site link and Ethernet can be used
for the other site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links
manual.

A maximum of one HPD GTR 8000 Expandable Site Subsystem can be added to a repeater site. The
example shows the maximum configuration. The Integrated Voice and Data (IV&D) ASTRO® 25
system base radio application software supports a maximum of 28 base radios and the HPD base
radio application software supports a maximum of five base radios.

The following information is about the receive, transmit, and network/site frequency reference (Net/Ref)
paths in the example:

• Receive path: HPD has receiver diversity. So, two Rx antennas are required (Rx-A and Rx-B),
which can handle a maximum of 48 base radios (24 times 2). Therefore, the HPD cabinet can be
the main Rx cabinet for the combined ASTRO® 25 system and HPD site, as shown in the example.
The two Rx antennas connected to the HPD GTR 8000 Expandable Site Subsystem support the
five HPD base radios and the 28 ASTRO® 25 system base radios in the example. Other
configurations are also possible.

• Transmit path: In the example, the line between combiners represents a phasing harness. A pair
of cabinets connected by a phasing harness must be one inch apart or less.
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• Net/Ref path: The GTR 8000 Expandable Site Subsystem containing the ASTRO® 25 system site
controllers must be the main Network/Site Reference cabinet for the HPD overlay as well as the
ASTRO® 25 system site. The internal LAN switches in the HPD site controllers connect to the
internal LAN switches in the ASTRO® 25 system site controllers. The Ethernet cables connect,
through the Network Expansion ports labeled Cab #5 (A,B) on the junction panel of the cabinet, to
the ASTRO® 25 system site controllers.

1.3.2

ASTRO 25 Repeater Site with HPD Overlay UHF R1 (380–450 MHz)
An example of an ASTRO® 25 repeater site with HPD overlay is shown in the following diagram.

Figure 19: Example of Repeater Site with HPD Overlay for UHF R1 (380–435 MHz)
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NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. There are actually two Net/Ref cables per cabinet, one for each of the redundant
site controllers and Expansion Hubs. Ethernet or T1/E1 links may be implemented to the zone
core. Ethernet links only are implemented to the zone controller in a Trunking Subsystem
(Tsub).

If hybrid redundant site links are used, T1/E1 can be used for one site link and Ethernet can be used
for the other site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links
manual.

A maximum of one HPD GTR 8000 Expandable Site Subsystem can be added to a repeater site. The
example shows the maximum configuration. The Integrated Voice and Data (IV&D) ASTRO® 25
system base radio application software supports a maximum of 28 base radios and the HPD base
radio application software supports a maximum of five base radios.

The following information is about the receive, transmit, and network/site frequency reference (Net/Ref)
paths in the example:

• Receive path: HPD has receiver diversity. So, two Rx antennas are required (Rx-A and Rx-B). The
HPD Rx antennas cannot support the ASTRO® 25 system UHF R1 GTR 8000 Base Radios. Each
ASTRO® 25 system UHF R1 cabinet has six BNC receive inputs on the junction panel to where the
RX outputs of the third-party RMC connect to.

• Transmit path: For TX path, there is a combiner, but only for the HPD channels.

• Net/Ref path: The GTR 8000 Expandable Site Subsystem containing the ASTRO® 25 system site
controllers must be the main Network/Site Reference cabinet for the HPD Overlay as well as the
ASTRO® 25 system site. The internal LAN switches in the HPD site controllers connect to the
internal LAN switches in the ASTRO® 25 system site controllers. The Ethernet cables connect,
through the Network Expansion ports labeled Cab #5 (A,B) on the junction panel of the cabinet, to
the ASTRO® 25 system site controllers.

1.3.3

ASTRO 25 Repeater Site with HPD Overlay UHF R2 (435–524 MHz)
An example of an ASTRO® 25 repeater site with HPD overlay is shown in the following diagram.
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Figure 20: Example of Repeater Site with HPD Overlay for UHF R2 (435–524 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 can be used for one site link and Ethernet can be used
for the other site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links
manual.

A maximum of one HPD GTR 8000 Expandable Site Subsystem can be added to a repeater site. The
example shows the maximum configuration. The Integrated Voice and Data (IV&D) ASTRO® 25
system base radio application software supports a maximum of 28 base radios and the HPD base
radio application software supports a maximum of five base radios.

The following information is about the receive, transmit, and network/site frequency reference (Net/Ref)
paths in the example:

• Receive path: HPD has receiver diversity. So, two Rx antennas are required (Rx-A and Rx-B).
Therefore, the HPD cabinet can be the main Rx cabinet for the HPD site, as shown in the example.
The first ASTRO® 25 system Rx antenna connected to the prime cabinet #1 supports the first 24
ASTRO® 25 system base radios in the example. Additional base radios need another Rx antenna.
Other configurations are also possible.

• Transmit path: There is a separate combiner in each cabinet. Each cabinet has one TX output
port. One TX antenna is required for each cabinet.

• Net/Ref path: The GTR 8000 Expandable Site Subsystem containing the ASTRO® 25 system site
controllers must be the main Network/Site Reference cabinet for the HPD Overlay as well as the
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ASTRO® 25 system site. The internal LAN switches in the HPD site controllers connect to the
internal LAN switches in the ASTRO® 25 system site controllers. The Ethernet cables connect,
through the Network Expansion ports labeled Cab #5 (A,B) on the junction panel of the cabinet, to
the ASTRO® 25 system site controllers.

1.3.4

ASTRO 25 Repeater Site with HPD Overlay VHF (136–174 MHz)
An example of an ASTRO® 25 repeater site with HPD overlay is shown in the following diagram.

Figure 21: Example of Repeater Site with HPD Overlay for VHF (136–174 MHz)

NOTICE: The two Net/Ref connections to and from each cabinet are represented by one line in
the example. Ethernet or T1/E1 links may be implemented to the zone core. Ethernet links only
are implemented to the zone controller in a Trunking Subsystem (Tsub).

If hybrid redundant site links are used, T1/E1 can be used for one site link and Ethernet can be used
for the other site link. See "Hybrid Site Links - Overview" in the Flexible Site and Interzone Links
manual.
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A maximum of one HPD GTR 8000 Expandable Site Subsystem can be added to a repeater site. The
example shows the maximum configuration. The Integrated Voice and Data (IV&D) ASTRO® 25
system base radio application software supports a maximum of 28 base radios and the HPD base
radio application software supports a maximum of five base radios.

The following information is about the receive, transmit, and network/site frequency reference (Net/Ref)
paths in the example shown:

• Receive path: HPD has receiver diversity. So, two Rx antennas are required (Rx-A and Rx-B).
Therefore, the HPD cabinet can be the main Rx cabinet for the HPD site, as shown in the example.
Each ASTRO® 25 system cabinet connects to the Rx antenna through a third-party supplied RMC
from the junction panel, in the example. Other configurations are also possible.

• Transmit path: Each ASTRO® 25 system cabinet feeds to the Tx antenna through a third-party
supplied combiner from the junction panel, in the example. Other configurations are also possible.
HPD connects directly into a Tx antenna from the junction panel.

• Net/Ref path: The GTR 8000 Expandable Site Subsystem containing the ASTRO® 25 system site
controllers must be the main Network/Site Reference cabinet for the HPD Overlay as well as
theASTRO® 25 system site. The internal LAN switches in the HPD site controllers connect to the
internal LAN switches in the ASTRO® 25 system site controllers. The Ethernet cables connect,
through the Network Expansion ports labeled Cab #5 (A,B) on the junction panel of the cabinet, to
the ASTRO® 25 system site controllers.

1.4

Conventional GTR 8000 Base Radio
Throughout this manual the term “conventional” addresses either an analog only base radio or an
ASTRO® 25 Conventional base radio that operates in either digital mode or mixed (analog/digital)
mode. The conventional base radios within the GTR 8000 Expandable Site Subsystem or standalone
GTR 8000 Base Radios operate within a Centralized Conventional Architecture. Each conventional
base radio uses either:

• a 2- or 4-wire EM interface in an analog infrastructure

• a V.24 interface for digital voice and data traffic to either a Channel Bank, Digital Interface Unit,
CCGW, MLC 8000, or ASTRO-TAC 3000 Comparator and an optional 4-wire link for analog voice in
a mixed mode configuration.

• an IP interface for digital voice and data traffic to a CCGW or GCM 8000 Comparator.

Up to a maximum of four conventional base radios can be installed in a trunked GTR 8000 Expandable
Site Subsystem cabinet/rack. The conventional base radios do not operate in trunked mode. All base
radios must be in the same frequency band.

Up to a maximum of six conventional base radios can be installed in a conventional only GTR 8000
Expandable Site Subsystem cabinet/rack. All base radios must be in the same frequency band.

NOTICE: For an overview of connecting to an ASTRO® 3.1 Conventional System, see the
Conventional Operations manual. The base radios can be IP managed while using the 4-wire V.
24 interface for channel traffic.

The conventional GTR 8000 Base Radio is available for 12.5 kHz operation in the 700 MHz, 800 MHz,
UHF R1 (380–435 MHz), UHF R2 (435–524 MHz), and VHF (136–174 MHz) frequency bands.
Settings for the conventional base radio are made through Unified Network Configurator (UNC) and
Configuration/Service Software (CSS).

NOTICE: While it is possible to configure a conventional base radio using UNC, it is preferable
to use the CSS since configuration dependencies are enforced.
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ASTRO 25 Conventional Base Radio
ASTRO® 25 Conventional base radio features include:

• Separate Tx and Rx network access codes

• Console or repeat priority

• Repeater set-up knockdown from the console

• Voice and data

• Receive-only station

• Voting

• Multicast

• Simulcast

• Console Control

• WildCard Operation

• Multi-Channel – up to 16 channels with base station or repeater functionality

• Multiple Network Access Code (Multi-NAC) Operation

• Scan Operation

• Analog Phone Patch

Analog Conventional Base Radio
Analog conventional base radio features include:

• 12.5 kHz analog channel operation with HearClear settings (800 MHz)

• Repeater Access Control

• Multi-Channel – up to 16 channel with base station or repeater functionality

• Alarm tones over-the-air and over-the-wireline

• Transmit Antenna Relay Control and Simplex Operations

• WildCard Operation

• EM INterfac; Ext PTT keying nd COR receiver I/O

• Analog simulcast support using Gen Tx and PL Analog inputs and Ext PTT and Ext PTT keying

• Multi-PL receive operation

• RA/RT configuration with analog 4–wire connections

• Analog Wireline Automatic Level Control (ALC)

• Wideband Receiver Operation

• Telephone Interconnect

• PL/DPL

• Tone Remote Control (TRC)

• Fall Back In-Cabinet (Automatic Mode)*

• In-Cabinet Repeater (External Mode)*

• Control Station

• Interfaces for local microphone and speaker

• Simplex operation

• Scan Operation
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• Voting

• Multicast

• Simulcast

For detailed information on the difference between the automatic Fallback In-Cabinet Repeat and the
externally-wired In-Cabinet Repeater functions, see the Conventional Operations manual.

1.5

Introduction – QUANTAR Stations
NOTICE: STR 3000 Base Radios are also supported at an ASTRO® 25 repeater site.

An ASTRO® 25 repeater site can support 10Base-T Ethernet Epic IV or Epic VI QUANTAR® stations,
or a mix of QUANTAR® stations with either standalone GTR 8000 Base Radios or GTR 8000
Expandable Site Subsystem cabinets/racks. An ASTRO® 25 repeater can support up to 28 channels
(27 voice channels, 1 control channel). If GTR 8000 Expandable Site Subsystem cabinets/racks are
used, the GCP 8000 Site Controllers can be either integrated into the primary cabinet/rack or in a
standalone configuration outside the primary cabinet/rack.

NOTICE: A mix of GTR 8000 Expandable Site Subsystem cabinet/racks and standalone GTR
8000 Base Radios is not supported.

The QUANTAR® stations operate in the 800 MHz, UHF R0 (380–433 MHz), UHF R1 (403–433 MHz),
UHF R2 (438–470 MHz), UHF R3 (470–494 MHz (UHF R4 (494–520 MHz) VHF R1 (132–154 MHz)
and VHF R2 (150–174 MHz) frequency bands.

Computer Software/Services (CSS) is used for configuration, alignment, and fault management for the
QUANTAR® stations.

NOTICE: An ASTRO® 25 repeater site that contains QUANTAR® stations (where only clear
SWDL transfer mode is supported) and GCP 8000 Site Controllers (where both clear and
secure SWDL transfer modes are supported), the clear SWDL transfer mode must be selected
to maintain a consistent transfer mode at the site.

The following system configurations are supported at an ASTRO® 25 repeater site with QUANTAR®

stations and GTR 8000 Expandable Site Subsystem cabinets/racks:

• GTR 8000 Expandable Site Subsystem with integrated GCP 8000 Site Controllers controlling six or
less QUANTAR® stations.

• GTR 8000 Expandable Site Subsystem with integrated GCP 8000 Site Controllers controlling more
than six QUANTAR® stations.

• GTR 8000 Expandable Site Subsystem with an external standalone GCP 8000 Site Controller
controlling QUANTAR® stations.

The following system configurations are supported at an ASTRO® 25 repeater site with QUANTAR®

stations with or without standalone GTR 8000 Base Radios:

• Standalone GCP 8000 Site Controllers controlling six or less QUANTAR® stations, or six or less of a
mix of QUANTAR® stations and standalone GTR 8000 Base Radios.

• Standalone GCP 8000 Site Controllers controlling more than six QUANTAR® stations, or a mix of
more than six QUANTAR® stations and standalone GTR 8000 Base Radios.

An ASTRO® 25 repeater site that employs QUANTAR® stations can have an additional five HPD
channels added to the site in an HPD overlay configuration. The HPD overlay configuration can consist
of a standalone HPD GCP 8000 Site Controller, standalone HPD GTR 8000 Base Radio, GTR 8000
Site Subsystem, or HPD GTR 8000 Expandable Site Subsystem. The HPD overlay equipment shares
the network medium to the zone core or zone controller in a Trunking Subsystem (Tsub) through one
or two Ethernet connections on the site LAN. Connections from the HPD site controller to the site LAN
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may be to the external Ethernet LAN switches or to the integrated LAN switches within the site
controllers.

TDMA operation is supported at an ASTRO® 25 repeater site with a mix of QUANTAR® stations and
GTR 8000 Base Radio, including Dynamic Dual Mode for the GTR 8000 Base Radios operating in
either FDMA mode or Phase 2 TDMA mode. The QUANTAR® stations operate only in FDMA mode.
The control capable channels must be GTR 8000 Base Radio channels when TDMA operation is
configured.

An ASTRO® 25 repeater site with a mix of QUANTAR® stations and GTR 8000 Base Radios supports
Dynamic System Resilience (DSR) functionality. DSR capability is established by configuring a
separate physical path to the backup zone core. The repeater site can switch over if the entire primary
zone core fails and remains in Wide Area Trunking mode.

An ASTRO® 25 repeater site with QUANTAR® stations may exist on an ASTRO® 25 system with a Next
Generation Interoperability (NGI) interface, but can only support the home radio/talkgroup IDs.
QUANTAR® stations in an ASTRO® 25 repeater site do not support foreign radio/talkgroup IDs to
register and affiliate. Therefore, for a foreign radio to affiliate on an ASTRO® 25 repeater site with
QUANTAR® stations, the foreign radio must be pre-configured with the system personality, subscriber
ID, and talkgroup IDs assigned from that ASTRO® 25 repeater site. For the foreign radio to gain access
to that ASTRO® 25 repeater site, the mode of the foreign radio must be manually selected to that
ASTRO® 25 repeater site.

An ASTRO® 25 repeater site with a mix of QUANTAR® stations and GTR 8000 Base Radios supports
Enhanced Data on the GTR 8000 Base Radios. The QUANTAR® stations do not support TDMA
operation, and are not capable of supporting Enhanced Data. The control capable channels must be
GTR 8000 Base Radio channels when Enhanced Data operation is configured.

For more information on the configurations, specifications, theory of operation, RFDS equipment, and
installation and connections see the following manuals:

• GTR 8000 Expandable Site Subsystem

• GTR 8000 Base Radio

• GCP 8000 Site Controller

• System LAN Switches

• GGM 8000 System Gateway

• S2500 and S2600 System Routers

• Simulcast Site Reference (TRAK)

1.5.1

ASTRO 25 Repeater Site – QUANTAR Stations and GTR 8000
Expandable Site Subsystem
The following system configurations are supported at an ASTRO® 25 repeater site with QUANTAR®

stations and GTR 8000 Expandable Site Subsystem cabinets/racks:

• GTR 8000 Expandable Site Subsystem with integrated GCP 8000 Site Controllers controlling six or
less QUANTAR® stations.

• GTR 8000 Expandable Site Subsystem with integrated GCP 8000 Site Controllers controlling more
than six QUANTAR® stations.

• GTR 8000 Expandable Site Subsystem with an external standalone GCP 8000 Site Controller
controlling more than six QUANTAR® stations.

• GTR 8000 Expandable Site Subsystem with an external standalone GCP 8000 Site Controller
controlling six or less QUANTAR® stations.
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NOTICE: A mix of GTR 8000 Expandable Site Subsystem cabinet/racks and standalone GTR
8000 Base Radios is not supported.

GTR 8000 Expandable Site Subsystem with Integrated GCP 8000 Site
Controllers with Six or Less QUANTAR Stations
The GTR 8000 Expandable Site Subsystem primary cabinet/rack contains two GCP 8000 Site
Controller modules with a maximum of six GTR 8000 Base Radios. Additional GTR 8000 Base Radios
are contained in expansion racks/cabinets containing XHubs.

A 5 MHz frequency reference is supplied to the QUANTAR® stations by either an internal UHSO or an
external TRAK 9100 or TRAK 8835 device. The following figure shows the site configured with a TRAK
device. The QUANTAR® stations connect directly to the junction panel of the primary cabinet that
houses the site controllers. See the “Junction Panel Connections” section in the GTR 8000 Expandable
Site Subsystem manual for connection details.

An interface between the two integrated Ethernet switches provides access to all the GTR 8000 Base
Radios and QUANTAR® by either site controller. The interface also makes it possible for any base
radio or base station to route its traffic to the site router or site gateway.

Figure 22: GTR 8000 Expandable Site Subsystem with Integrated GCP 8000 Site Controllers
with Six or Less QUANTAR Stations
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Traffic is routed using single or dual routers or gateways. If using a single router or gateway
configuration, failure of the router or gateway causes failure of both zone controller and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
supported are transmission trunked and terminated. The dual site router or gateway configuration
provides the highest level of redundancy to the subsystem. If one of the two routers fails, the site
remains in wide area trunking mode.
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The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

Each QUANTAR® station is connected to only one site controller. If a single site controller fails, the
QUANTAR® stations connected to the failed site controller enter Failsoft mode and all existing calls are
transmission trunked and terminated.

GTR 8000 Expandable Site Subsystem with Integrated GCP 8000 Site
Controllers with More than Six QUANTAR Stations
The GTR 8000 Expandable Site Subsystem primary cabinet/rack contains two GCP 8000 Site
Controller modules with a maximum of six GTR 8000 Base Radios. Additional GTR 8000 Base Radios
are contained in expansion racks/cabinets containing XHubs.

External LAN switches connect directly to the QUANTAR® stations and junction panel of the prime
cabinet. See the “Junction Panel Connections” section in the GTR 8000 Expandable Site Subsystem
manual for connection details.

A 5 MHz frequency reference is supplied to the QUANTAR® stations by either an internal UHSO or an
external TRAK 9100 or TRAK 8835 device. The following figure shows the site configured with a TRAK
device.

NOTICE: The TRAK 9100 must be used when more than eight QUANTAR® stations that
require external references are at the site.

Figure 23: GTR 8000 Expandable Site Subsystem with Integrated GCP 8000 Site Controllers
with More than Six QUANTAR Stations
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Traffic is routed using single site router or gateway and single LAN switch; single site router or gateway
and dual LAN switches; or dual site routers or gateways and dual LAN switches. Failure of a single site
router, gateway, or single LAN switch configuration causes failure of both zone controller and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
supported are transmission trunked and terminated. The dual site router or gateway and dual LAN
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switch configuration provides the highest level of redundancy to the subsystem. If one of the two
routers fails or one of the links to the zone core or zone controller in a Trunking Subsystem (Tsub)
through these routers fails, the site remains in wide area trunking mode.

NOTICE: In a dual LAN switches configuration, both site controllers are connected to their
respective LAN switches. To prevent a switched network loop, there is no Ethernet link between
the two LAN switches.

The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

Each QUANTAR® station is connected to only one site controller. If a single site controller fails, the
QUANTAR® stations connected to the failed site controller enter Failsoft mode and all existing calls are
transmission trunked and terminated.

NOTICE: A Dual LAN switch configuration is required with more than 18 QUANTAR® stations.

GTR 8000 Expandable Site Subsystem with an External Standalone GCP 8000
Site Controller with More than Six QUANTAR Stations
The GTR 8000 Expandable Site Subsystem cabinet/rack contains two XHub modules with a maximum
of six GTR 8000 Base Radios. Additional GTR 8000 Base Radios are contained in expansion racks/
cabinets containing XHubs. The GCP 8000 Site Controllers are in a standalone configuration outside
the cabinet/rack and is comprised of one chassis that holds two site controller modules that have
integrated LAN switches. The site controller connections are made to the junction panels of each GTR
8000 Expandable Site Subsystem cabinet/rack. See the “Junction Panel Connections” section in the
GTR 8000 Expandable Site Subsystem manual for connection details.

External LAN switches connect directly to the QUANTAR® stations and site controllers.

A 5 MHz frequency reference is supplied to the QUANTAR® stations by either an internal UHSO or an
external TRAK 9100 or TRAK 8835 device. The following figure shows the site configured with a TRAK
device.

NOTICE: The TRAK 9100 must be used when more than eight QUANTAR® stations that
require external references are at the site.
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Figure 24: GTR 8000 Expandable Site Subsystem with an External Standalone GCP 8000 Site
Controller with More than Six QUANTAR Stations

. .
 . 

. .

. .
 . 

. .

Site
Router

Site
Router

Et
he

rn
et

QUANTAR 1

QUANTAR 3

QUANTAR“N”

GCP 8000
Site Controller

5 
M

H
z

Switch Switch

Ethernet

QUANTAR 2

QUANTAR 4

QUANTAR“N”

TRAK

5 MHz

A25_ESS_Standalone_morethan6_C

ESS with 
XHUB and GTRs

Net/Ref

Traffic is routed using single site router or gateway and single LAN switch; single site router or gateway
and dual LAN switches; or dual site routers or gateways and dual LAN switches. Failure of a single site
router, gateway, or single LAN switch configuration causes failure of both zone controller and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
supported are transmission trunked and terminated. The dual site router or gateway and dual LAN
switch configuration provides the highest level of redundancy to the subsystem. If one of the two
routers fails or one of the links to the zone core or zone controller in a Trunking Subsystem (Tsub)
through these routers fails, the site remains in wide area trunking mode.

NOTICE: In a dual LAN switches configuration, both site controllers are connected to their
respective LAN switches. To prevent a switched network loop, there is no Ethernet link between
the two LAN switches.

The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

The QUANTAR® stations are connected to only one site controller. If a single site controller fails, the
QUANTAR® stations connected to the failed site controller enter Failsoft mode and all existing calls are
transmission trunked and terminated.

NOTICE: A Dual LAN switch configuration is required with more than 18 QUANTAR® stations.
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GTR 8000 Expandable Site Subsystem with an External Standalone GCP 8000
Site Controller with Six or Less QUANTAR Stations
The GTR 8000 Expandable Site Subsystem cabinet/rack contains two XHub modules with a maximum
of six GTR 8000 Base Radios. Additional GTR 8000 Base Radios are contained in expansion racks/
cabinets containing XHubs. The GCP 8000 Site Controllers are in a standalone configuration outside
the cabinet/rack and is comprised of one chassis that holds two site controller modules that have
integrated LAN switches. The site controller connections are made to the junction panels of each GTR
8000 Expandable Site Subsystem cabinet/rack. See the “Junction Panel Connections” section in the
GTR 8000 Expandable Site Subsystem manual for connection details.

The QUANTAR® stations connect directly to the site controller modules. See the “GCP 8000 Site
Controller Ports for Standalone and GTR 8000 Site Subsystem Configurations (Rear View)” section in
the GCP 8000 Site Controller manual for connection details.

An interface between the two integrated Ethernet LAN switches provides access to all the QUANTAR®

stations and GTR 8000 Base Radios by both site controller modules. The interface also makes it
possible for any base radio or station to route its traffic to the site router or site gateway.

A 5 MHz frequency reference is supplied to the QUANTAR® stations by either an internal UHSO or an
external TRAK 9100 or TRAK 8835 device. The following figure shows the site configured with a TRAK
device.

Figure 25: GTR 8000 Expandable Site Subsystem with an External Standalone GCP 8000 Site
Controller with Six or Less QUANTAR Stations
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Traffic is routed using a single site router or gateway configuration or a dual site router or gateway
configuration. Failure of a single site router or gateway configuration causes failure of both zone
controller and RF site controller paths and, in turn, forces the site into Site Trunking mode. All existing
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calls that are being supported are transmission trunked and terminated. The dual site router or
gateway configuration provides the highest level of redundancy to the subsystem. If one of the two
routers fails or one of the links to the zone core or zone controller in a Trunking Subsystem (Tsub)
through these routers fails, the site remains in wide area trunking mode.

The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

The QUANTAR® stations are connected to only one site controller. If a single site controller fails, the
QUANTAR® stations connected to the failed site controller enter Failsoft mode and all existing calls are
transmission trunked and terminated.

1.5.2

ASTRO 25 Repeater Site – QUANTAR Stations
The following system configurations are supported at an ASTRO® 25 repeater site with QUANTAR®

stations:

• Standalone GCP 8000 Site Controllers controlling six or less QUANTAR® stations with or without
standalone GTR 8000 Base Radios

• Standalone GCP 8000 Site Controllers controlling more than six QUANTAR® stations with or
without standalone GTR 8000 Base Radios

NOTICE: A mix of standalone GTR 8000 Base Radios and GTR 8000 Expandable Site
Subsystem cabinet/racks is not supported.

Standalone GCP 8000 Site Controllers with Six or Less QUANTAR Stations and
GTR 8000 Base Radios
The ASTRO® 25 repeater site contains a standalone GCP 8000 Site Controller comprised of one
chassis that holds two site controller modules that have embedded LAN switches, six or less
QUANTAR® stations, or a mix of six or less QUANTAR® stations and standalone GTR 8000 Base
Radios.

A 5 MHz frequency reference is supplied to the QUANTAR® stations by either an internal UHSO or an
external TRAK 9100 or TRAK 8835 device. The following figure shows the site configured with a TRAK
device. The QUANTAR® stations connect directly to the site controller modules. See the “GCP 8000
Site Controller Ports for Standalone and GTR 8000 Site Subsystem Configurations (Rear View)”
section in the GCP 8000 Site Controller manual for connection details.

An interface between the two integrated Ethernet LAN switches provides access to all the QUANTAR®

stations and GTR 8000 Base Radios by both site controller modules. The interface also makes it
possible for any base radio or station to route its traffic to the site router or site gateway.
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Figure 26: Standalone GCP 8000 Site Controllers with Six or Less QUANTAR Stations and GTR
8000 Base Radios (Example)
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Traffic is routed using single or dual routers or gateways. Failure of a single site router or gateway
configuration causes failure of both zone controller and RF site controller paths and, in turn, forces the
site into Site Trunking mode. All existing calls that are being supported are transmission trunked and
terminated. The dual site router or gateway configuration provides the highest level of redundancy to
the subsystem. If one of the two routers fails, the site remains in wide area trunking mode.

The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

Each QUANTAR® station is connected to only one site controller. If a single site controller fails, the
QUANTAR® stations connected to the failed site controller enter Failsoft mode and all existing calls are
transmission trunked and terminated.

Standalone GCP 8000 Site Controllers with More than Six QUANTAR Stations
and GTR 8000 Base Radios
The ASTRO® 25 repeater site contains a standalone GCP 8000 Site Controller comprised of one
chassis that holds two site controller modules that have embedded LAN switches, six or more
QUANTAR® stations, or a mix of six or more QUANTAR® stations and standalone GTR 8000 Base
Radios.

External LAN switches connect directly to the QUANTAR® stations and GTR 8000 Base Radios. The
site controllers connect to the external LAN switches. See the “GCP 8000 Site Controller Ports (Front
View)” section in the GCP 8000 Site Controller manual for connection details.

A 5 MHz frequency reference is supplied to the QUANTAR® stations by either an internal UHSO or an
external TRAK 9100 or TRAK 8835 device. The TRAK provides a 5 MHz frequency reference to the
GTR 8000 Base Radios. For sites with TDMA or Enhanced Data, the TRAK provides composite 5 MHz
+ 1PPS signal sourcing to the GTR 8000 Base Radios, and 1PPS time reference to the site controllers.

NOTICE: The TRAK 9100 must be used when more than eight channels that require external
references are at the site.
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Figure 27: Standalone GCP 8000 Site Controllers with More than Six QUANTAR Stations and
GTR 8000 Base Radios (Example)
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Traffic is routed using single site router or gateway and single LAN switch; single site router or gateway
and dual LAN switches; or dual site routers or gateways and dual LAN switches. Failure of a single site
router, gateway, or LAN switch configuration causes failure of both zone controller and RF site
controller paths and, in turn, forces the site into Site Trunking mode. All existing calls that are being
supported are transmission trunked and terminated. The dual site router or gateway and dual LAN
switch configuration provides the highest level of redundancy to the subsystem. If one of the two
routers fails or one of the links to the zone core or zone controller in a Trunking Subsystem (Tsub)
through these routers fails, the site remains in wide area trunking mode.

NOTICE: In a dual LAN switches configuration, both site controllers are connected to their
respective LAN switches. To prevent a switched network loop, there is no Ethernet link between
the two LAN switches.

The GTR 8000 Base Radios are connected to both redundant site controllers. If a single site controller
fails, the site continues to operate in wide area trunking mode and existing calls are not affected. If
both site controllers fail, then the site enters the Failsoft mode.

Each QUANTAR® station is connected to only one site controller. If a single site controller fails, the
QUANTAR® stations connected to the failed site controller enter Failsoft mode and all existing calls are
transmission trunked and terminated.

NOTICE: A Dual LAN switch configuration is required with more than 18 channels.
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1.6

ASTRO 25 Repeater Site Subsystem Trunked Single-Site
Configuration
This configuration consists of GTR 8000 Base Radios and GCP 8000 Site Controllers in a single-site
repeater configuration. The base radios may be colocated with the site controllers within the GTR 8000
Expandable Site Subsystem cabinet, or be separated (standalone, non-colocated) from the site
controllers. For additional information on a Trunked Single-Site Repeater configuration, see Chapter 1,
“Overview For a GTR 8000 Expandable Site Subsystem in a Trunked Single-Site Repeater
Configuration” in the GTR 8000 Expandable Site Subsystem manual.

1.7

Point-to-Point Components
Each Repeater Site subsystem configuration can support Point-to-Point components (PTP) using
T1/E1 or Ethernet site links.

1.7.1

ASTRO 25 Repeater Site – PTP with T1 Links
A repeater site with T1/E1 site links can be configured to support fault management of antenna
equipment using PTP equipment.

Figure 28: Repeater Site Subsystem Configuration With Point-To-Point Components using
T1/E1 Links
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Figure 29: Repeater Site Subsystem Configuration With Point-To-Point Components using
T1/E1 Links with “Last Hop”

See the Fault Management Reference Guide manual for details regarding implementation of PTP
devices to fault manage antenna equipment.

1.7.2

ASTRO 25 Repeater Site – PTP with Ethernet Links
A repeater site with Ethernet site links can be configured to support fault management of antenna
equipment using PTP equipment.

Figure 30: Repeater Site Subsystem Configuration With Point-To-Point Components using
Ethernet Links
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Figure 31: Repeater Site Subsystem Configuration With Point-To-Point Components using
Ethernet Links with “Last Hop”

See the Fault Management Reference Guide manual for details regarding implementation of PTP
devices to fault manage antenna equipment.
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Chapter 2

Theory of Operation
This chapter explains how the devices work in the context of an ASTRO® 25 repeater site.

2.1

GCP 8000 Site Controller
An ASTRO® 25 repeater site contains two GCP 8000 Site Controllers which provide protection against
a single point of failure. Each site controller is programmed with a set of rules that helps the site
controller determine which one of the two assumes the role of primary site controller initially and when
it is necessary for the other site controller to take over the operation of the subsystem. If the active site
controller fails, the other site controller automatically takes control of the site. The site controller
provides the following functions at the site:

• Manages the site and channels

• Forwards registration and context activation requests

• Administers broadcasts

• Provides a time and frequency reference signal to the GTR 8000 base radios

• Monitors GTR 8000 Base Radios, QUANTAR® stations, and RF distribution equipment

• Interacts with MOSCAD NFM site device manager

• Provides redundant site control

NOTICE: If the site controllers are integrated into a GTR 8000 Expandable Site Subsystem with
more than one cabinet/rack, it is not necessary to include site controllers in the expansion
cabinet/racks. In expansion cabinets/racks, expansion hubs (XHubs) are used instead of site
controllers to provide network and reference connections between cabinets/racks.

A service laptop/computer, loaded with the Configuration/Service Software (CSS) application, can be
connected to a port on the Ethernet switch to conduct programming changes or troubleshooting
services.

2.2

Communication Links
The network infrastructure at an ASTRO® 25 repeater site includes a site router or gateway. Based on
the number of channels at the site, two 10/100Base-T Ethernet switches (integrated with the site
controllers) or external LAN switches provide ports for interfacing the channels, site routers or
gateways, and MOSCAD NFM.

The site routers or gateways process the physical and logical data link to support communication
between the zone controller and the site controller. The site router or gateway provides a WAN
interface that handles all traffic to and from the zone for the RF Site including voice, control, data, and
Network Management traffic. The site router or gateway also provides the connection between the LAN
and the transport network. Communication between site controllers, site Ethernet switches and all the
channels takes place through a dedicated LAN.

NOTICE: If Dynamic System Resilience (DSR) is implemented on your system, more than one
border router or border gateway is used to support data traffic, one to connect to the primary
zone core from the CEN and another to connect to the backup zone core. See the Dynamic
System Resilience manual for details.
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A channel bank is installed as part of the subsystem only if conventional channels are required at the
geographical site. Conventional audio uses the same transport facilities as the ASTRO® 25 system, but
is not processed by the IP components in the network. The IP-based devices in the system are not
aware of the existence of conventional audio. The channel bank also connects to a FlexWAN port on
the site routers or gateways to transport voice and network management data IP packets to and from
the zone core.

2.3

Radio Frequency Distribution System
A GTR 8000 Expandable Site Subsystem can contain Radio Frequency Distribution System (RFDS)
equipment which provides the interface between the base radios and the site antennas. The RFDS
equipment is structured to be an optional part of the GTR 8000 Expandable Site Subsystem for
800/900 MHz and UHF R2 (435–524 MHz) systems. However for 700 MHz systems, the Motorola
Solutions RFDS equipment is mandatory.

NOTICE: For 700 MHz GTR 8000 Expandable Site Subsystems, it is required to purchase the
integrated RFDS equipment with the GTR 8000 Expandable Site Subsystem.

Radio frequency distribution at a GTR 8000 Expandable Site Subsystem is accomplished through
equipment that includes the receive and transmit antennas, isolators, multicouplers, and combiners.

2.4

Remote Site Routers or Gateways
The remote site router or gateway provides a Wide Area Network (WAN) interface that handles all the
traffic to and from the zone core or zone controller in a Trunking Subsystem (Tsub) for the Radio
Frequency (RF) site. This traffic includes voice, control, data, and network management traffic.

The remote site router or gateway handles traffic between the remote site network and the T1/E1 or
Ethernet link to the zone core or (Tsub). The remote site router or gateway distributes the network
management traffic to the equipment on the remote site network. The remote site router or gateway
provides the following functions:

Traffic prioritizing
Applies the correct prioritizing masking to the packets leaving the site.

Fragmentation
Fragments large IP packets as per standards

Dynamic Host Configuration Protocol (DHCP) service
This service allows a technician with a properly configured Windows PC to connect to the LAN at
the site.

Redundancy
There can be two routers or gateways at the repeater site, which provide redundancy. While one of
the routers or gateways is operational, the other router or gateway is redundant. This optional
redundant remote site router or gateway and the redundant links to the redundant router or gateway
provides protection from a single point of failure or single WAN link failure.

Information on Ethernet connectivity between the sites and zones is available in the Flexible Site and
InterZone Links manual.

2.5

Ethernet LAN Switch
At an ASTRO® 25 repeater site, up to two HP 2620-24 Ethernet LAN switches are used when more
than six QUANTAR® stations and/or standalone GTR 8000 Base Radios are at the site, or a GTR 8000
Expandable Site Subsystem cabinet/rack with an external GCP 8000 Site Controller is at the site. The
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Ethernet LAN switch supports the remote site LAN to support the audio, data, and network
management traffic.

The Ethernet LAN switch has 24 ports that provide the connectivity for a 10/100BaseT LAN. An
optional, second Ethernet LAN switch can be added to accommodate additional channels and to
provide a second link to the prime site. The dual LAN switch configuration also provides a degree of
protection in the case of a switch failure. If one switch fails, a link still exists to the channels connected
to the unaffected switch. In a dual LAN configuration, both site controllers are connected to their
respective LAN switches. To prevent a switched network loop, the Ethernet link between the two site
controllers must be disabled.

One switch connects to a site router or gateway, the optional MOSCAD NFM, and half the channels.
An additional switch connects to the remaining channels and to another optional site router or gateway.

10BaseT half duplex connections are made to the channels and the optional MOSCAD NFM. A
100BaseT full duplex connection is made to the site routers or gateways.

NOTICE: A Dual Ethernet LAN switch configuration is needed when there are more than 18
channels at the site.

2.6

TRAK 9100 and TRAK 8835
The TRAK 9100 or TRAK 8835 is used at an ASTRO® 25 repeater site when there are QUANTAR®

stations without an internal UHSO or when there are standalone GTR 8000 Base Radios with or
without QUANTAR® stations totaling more than six at the site. The TRAK provides a 5 MHz frequency
reference to each QUANTAR® station and each standalone GTR 8000 Base Radio. For TDMA and
Enhanced Data, the TRAK provides a composite (1PPS+5 MPPS) signal to the standalone GTR 8000
Base Radios and a 1PPS signal to the GCP 8000 Site Controller. These signals establish frequency
references for transmit and receive frequencies at the channels. For detailed information on the TRAK,
see the Simulcast Site Reference manual.

NOTICE: A single TRAK 8835 supports up to eight channels that require external references.
When more than eight channels are at the site that require external references, use a TRAK
9100 or multiple TRAK 8835 devices.

2.7

GTR 8000 Expandable Site Subsystem Operating
Configurations (700/800/900 MHz)

Table 1: ASTRO 25 System Repeater Site GTR 8000 Expandable Site Configurations for 700/800/900
MHz

Connection Description

Transmit A maximum of 12 base radios can be combined. So no more than two cabinets
(six base radios in each) can be combined per transmit antenna.
The cabinets must be located next to each other. No doors can be installed on
the sides that face each other.

The cabinet which connects to the transmit antenna must be configured with a
TX filter (if both cabinets are same band) or diplexer (if different band than other
cabinet).

The other cabinet must be configured with a phasing harness (if both cabinets
are same band) or diplexer extension cable (if different band than other cabi-

Table continued…
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Connection Description

net). Cabinets connected by a phasing harness or a diplexer extension cable
must be one in. apart or less.

All necessary TX RF interconnect cables (critical length) are provided in these
options. The interconnect cable goes directly between RFDS components of the
two cabinets without using the junction panel. The output TX antenna connec-
tion is a 7/16 DIN on the junction panel.

Receive Up to four cabinets (24 base radios) can use a single receive antenna. A con-
nection point is provided on the junction panel with output for the other cabinets.
Cables that connect the cabinets are NOT provided.
There is a Site Preselector in cabinets that connect to the Rx antenna.

Ethernet Each trunked base radio at the site has an Ethernet connection to the site LAN.
This connection provides an interface for network management and voice or
control traffic for the individual base radios. The transceiver (XCVR) in each
base radio provides conversion between the inbound and outbound IP packets
and the control or voice traffic. The Ethernet connection also supports network
management traffic for the radio. The Ethernet link supports fault reporting, soft-
ware downloads, CSS connections, and other network management traffic.
Each Expansion Hub in the expansion cabinets contains an incremental 8-port
Ethernet switch which augments, in a hierarchical fashion, the main switch in
the site controller, and supports up to six base radios.

700 MHz cabi-
net connected
to an 800 MHz
cabinet

For side-by-side dual band cabinets (a 700 MHz cabinet connected to an 800
MHz cabinet), the following is required, in addition to the transmit configuration
requirements previously listed:

• Only one Tx antenna is needed.

• Only one Rx antenna is needed.

• A diplexer is used instead of a transmit filter in one of the cabinets.

• The TX connection between combiners is a diplexer extension cable instead
of the phasing harness used for single band cabinets.

2.8

GTR 8000 Expandable Site Subsystem Operating
Configurations for UHF R1 (380–435 MHz)

Table 2: ASTRO 25 System Repeater Site GTR 8000 Expandable Site Subsystem Configurations for
UHF R1 (380–435 MHz)

Connection Description

Transmit The Power Amplifier output of each base radio is connected to the QN to
N jumper cable to the external Third-Party Combiner inputs, through the
junction panel on top of the cabinet.
All ASTRO® 25 system cabinets can be combined into a third-party sup-
plied combiner that feeds into one transmit antenna.

If f the PMU option is not included, the output TX antenna connection is a
six-N female inside the cabinet.

Refer to the manufacturer documentation.

Table continued…
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Connection Description

Receive The external Third-Party RMC outputs are connected to six BNC Receive
Inputs on the junction panel in each cabinet.
All ASTRO® 25 system cabinets can be combined into a third-party sup-
plied RMC that feeds into one receive antenna.

Refer to the manufacturer documentation.

Ethernet Each trunked base radio at the site has Ethernet connection to the site
LAN. This connection provides an interface for network management and
voice or control traffic for the individual base radios. The transceiver
(XCVR) in each base radio provides conversion between the inbound and
outbound IP packets and the control or voice traffic. The Ethernet connec-
tion also supports network management traffic for the radio. The Ethernet
link supports fault reporting, software downloads, CSS connections, and
other network management traffic. Each Expansion Hub in the expansion
cabinets contains an incremental 8-port Ethernet switch which augments,
in a hierarchical fashion, the main switch in the site controller, and sup-
ports up to six base radios.

2.9

GTR 8000 Expandable Site Subsystem Operating
Configurations for UHF R2 (435–524 MHz)

Table 3: ASTRO 25 System Repeater Site GTR 8000 Expandable Site Subsystem Configurations for
UHF R2 (435–524 MHz)

Connection Description

Transmit A maximum of six base radios can be combined. So no more than one
cabinet (six base radios in each) can be combined per transmit antenna.
The cabinet that connects to the transmit antenna must be configured
with a TX filter.

The output TX antenna connection is a 7/16 DIN on the junction panel.

Receive Up to four cabinets (24 base radios) can use a single receive antenna. A
connection point is provided on the junction panel with output for the other
cabinets. Cables that connect the cabinets are NOT provided.
There is a Site Preselector in cabinets that connect to the Rx antenna.

Ethernet Each trunked base radio at the site has Ethernet connection to the site
LAN. This connection provides an interface for network management and
voice or control traffic for the individual base radios. The transceiver
(XCVR) in each base radio provides conversion between the inbound and
outbound IP packets and the control or voice traffic. The Ethernet connec-
tion also supports network management traffic for the radio. The Ethernet
link supports fault reporting, software downloads, CSS connections, and
other network management traffic.
Each Expansion Hub in the expansion cabinets contains an incremental
8-port Ethernet switch which augments, in a hierarchical fashion, the main
switch in the site controller, and supports up to six base radios.
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2.10

GTR 8000 Expandable Site Subsystem Operating
Configurations for VHF (136–174 MHz)

Table 4: ASTRO 25 System Repeater Site GTR 8000 Expandable Site Subsystem Configurations for
VHF (136–174 MHz)

Connection Description

Transmit All ASTRO® 25 system cabinets can be combined into a third-party sup-
plied combiner that feeds into one transmit antenna.
If the PMU option is not included, the output TX antenna connection is a
six-N female inside the cabinet.

See the manufacturer documentation.

Receive All ASTRO® 25 system cabinets can be combined into a third-party sup-
plied RMC that feeds into one receive antenna.
The input RX antenna connection is a 6-BNC female connectors on the
junction panel.

See the manufacturer documentation.

Ethernet Each trunked base radio at the site has Ethernet connection to the site
LAN. This connection provides an interface for network management and
voice or control traffic for the individual base radios. The transceiver
(XCVR) in each base radio provides conversion between the inbound and
outbound IP packets and the control or voice traffic. The Ethernet connec-
tion also supports network management traffic for the radio. The Ethernet
link supports fault reporting, software downloads, CSS connections, and
other network management traffic.
Each Expansion Hub in the expansion cabinets contains an incremental
8-port Ethernet switch which augments, in a hierarchical fashion, the main
switch in the site controller, and supports up to six base radios.
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Chapter 3

Installation
This chapter details installation procedures relating to the ASTRO® 25 repeater site.

3.1

Site Configurations for (700/800/900 MHz)
The following types of equipment may be at an ASTRO® 25 repeater site with GTR 8000 Expandable
Site Subsystem cabinets:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• GCP 8000 Site Controller with redundant modules (for cabinet one and the HPD overlay cabinet if
used)

• Standalone GCP 8000 Site Controller with redundant modules

• A remote Global Navigation Satellite System (GNSS) unit for each site controller in the HPD overlay
cabinet if used

• Expansion Hubs with redundant modules (for cabinets two to five) (cabinets one to five if used with
standalone GCP 8000 Site Controller)

• Two to six GTR 8000 Base Radios for primary cabinet

• One to six GTR 8000 Base Radios for expansion cabinets

• Up to 27 QUANTAR® stations (800 MHz only)

• Two to five GTR 8000 Base Radios for HPD overlay cabinet

• Up to six GTR 8000 Expandable Site Subsystem cabinets (with HPD overlay)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

The following types of equipment may be at an ASTRO® 25 repeater site with standalone GTR 8000
Base Radios:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• Standalone GCP 8000 Site Controller with redundant modules

• A remote GNSS unit for each site controller in the HPD overlay cabinet if used

• Up to 28 standalone GTR 8000 Base Radios (700/800 MHz only)

• Up to 28 QUANTAR® stations (700/800 MHz only)

• One to five GTR 8000 Base Radios (for HPD overlay if used)

• GCP 8000 Site Controller with redundant modules (for HPD overlay if used)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device
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3.2

Site Configurations for UHF R1 (380–435 MHz)
The following types of equipment may be at an ASTRO® 25 repeater site with GTR 8000 Expandable
Site Subsystem cabinets:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• GCP 8000 Site Controller with redundant modules (for cabinet one and the HPD overlay cabinet if
used)

• Standalone GCP 8000 Site Controller with redundant modules

• A remote Global Navigation Satellite System (GNSS) unit for each site controller in the HPD overlay
cabinet if used

• Expansion Hubs with redundant modules (for cabinets two to five) (cabinets one to five if used with
standalone GCP 8000 Site Controller)

• Two to six GTR 8000 Base Radios for primary cabinet

• One to six GTR 8000 Base Radios for expansion cabinets

• Up to 27 QUANTAR® stations

• Two to five GTR 8000 Base Radios for HPD overlay cabinet

• Up to six GTR 8000 Expandable Site Subsystem cabinets (with HPD overlay)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

• One Third-party RMC

• One Third-party Combiner

The following types of equipment may be at an ASTRO® 25 repeater site with standalone GTR 8000
Base Radios:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• Standalone GCP 8000 Site Controller with redundant modules

• A remote GNSS unit for each site controller in the HPD overlay cabinet if used

• Up to 28 standalone GTR 8000 Base Radios

• Up to 28 QUANTAR® stations

• One to five GTR 8000 Base Radios (for HPD overlay if used)

• GCP 8000 Site Controller with redundant modules (for HPD overlay if used)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

3.3

Site Configurations for UHF R2 (435–524 MHz)
The following types of equipment may be at an ASTRO® 25 repeater site with GTR 8000 Expandable
Site Subsystem cabinets:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches
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• GCP 8000 Site Controller with redundant modules (for cabinet one and the HPD overlay cabinet if
used)

• Standalone GCP 8000 Site Controller with redundant modules

• A remote Global Navigation Satellite System (GNSS) unit for each site controller in the HPD overlay
cabinet if used

• Expansion Hubs with redundant modules (for cabinets two to five) (cabinets one to five if used with
a standalone GCP 8000 Site Controller)

• Two to six GTR 8000 Base Radios for primary cabinet

• One to six GTR 8000 Base Radios for expansion cabinets

• Up to 27 QUANTAR® stations

• Two to five GTR 8000 Base Radios for HPD overlay cabinet

• One to six GTR 8000 Expandable Site Subsystem cabinets (with HPD overlay)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

The following types of equipment may be at an ASTRO® 25 repeater site with standalone GTR 8000
Base Radios:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• Standalone GCP 8000 Site Controller with redundant modules

• A remote GNSS unit for each site controller in the HPD overlay cabinet if used

• Up to 28 standalone GTR 8000 Base Radios

• Up to 28 QUANTAR® stations

• One to five GTR 8000 Base Radios (for HPD overlay if used)

• GCP 8000 Site Controller with redundant modules (for HPD overlay if used)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

3.4

Site Configurations for VHF (136–174 MHz)
The following types of equipment may be at an ASTRO® 25 repeater site with GTR 8000 Expandable
Site Subsystem cabinets:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• GCP 8000 Site Controller with redundant modules (for cabinet one and the HPD overlay cabinet if
used)

• Standalone GCP Site Controller with redundant modules

• A remote Global Navigation Satellite System (GNSS) unit for each site controller in the HPD overlay
cabinet if used

• Expansion Hubs with redundant modules (for cabinets two to five) (cabinets one to five is used with
standalone GCP 8000 Site Controller)

• Two to six GTR 8000 Base Radios for primary cabinet

• One to six GTR 8000 Base Radios for expansion cabinets
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• Up to 27 QUANTAR® stations

• Two to five GTR 8000 Base Radios for HPD overlay cabinet

• One to six GTR 8000 Expandable Site Subsystem cabinets (with HPD overlay)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

• One Third-party RMC

• One Third-party Combiner

The following types of equipment may be at an ASTRO® 25 repeater site with standalone GTR 8000
Base Radios:

• One or two site routers or gateways (with one or two site links)

• One or two Ethernet LAN switches

• Standalone GCP 8000 Site Controller with redundant modules

• A remote GNSS unit for each site controller in the HPD overlay cabinet if used

• Up to 28 standalone GTR 8000 Base Radios

• Up to 28 QUANTAR® stations

• One to five GTR 8000 Base Radios (for HPD overlay if used)

• GCP 8000 Site Controller with redundant modules (for HPD overlay if used)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM monitoring device

3.5

Installation Overview Process
When and where to use: Standards and Guidelines for Communication Sites includes guidelines and
details for designing and installing equipment at an RF site. Refer to the document for the following
guidelines on the site installation:

• Safety guidelines

• Site selection, design, and development

• Site building design and installation

• External/internal grounding

• Power sources

• Transient voltage surge suppression

• Minimizing site interference

• Equipment installation

• Antenna installation

This process provides a general description of the process for installing racks, cabinets, and devices in
the remote site.

Process:

1 Prepare each site to comply with the Motorola Solutions requirements and specifications for the
equipment, as listed in the Standards and Guidelines for Communication Sites. Other codes and
guidelines that may apply to the location must also be met.
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2 Inspect and inventory all racks, cabinets, cables, and other equipment with a Motorola Solutions
representative to ensure that the order is complete.

3 Install all equipment using the site drawings and other documents provided by the Field
Engineer. Use the installation standards and guidelines for placing and installing equipment.

4 Install all groundings for the racks and cabinets to protect against ground faults, electrical
surges, and lightning in accordance with R56 standards.

5 Connect all cables within each rack and between multiple racks (where required).

6 Run a preliminary check of all sites before applying power and starting the initial software
installations.

3.5.1

Required Tools for Hardware Installation
A variety of tools are required to install, optimize, and service the equipment. If information is needed
regarding where to obtain any of the equipment and tools listed, contact the Motorola Solutions
Support Center (SSC). The following is a list of general recommended tools for installing and servicing
equipment at an HPD remote site:

• 150 MHz 4-channel digital storage oscilloscope

• Transmission test set (TIMS Set)

• Digital multimeter (DMM)

• Terminal emulation software

• DB-9 straight-through serial cable

• RS-232 cables with connectors

• Punch block impact tool

• MODAPT RJ-45 breakout box

• Remote RJ-11/RJ-45 cable tester (1,200 ft length maximum)

• PC cable tester with RG58, 59, 62, BNC, RJ-45, RJ11, DB-9, DB15, DB25, and Centronics 36-pin
connectors

• Electrostatic discharge (ESD) field service kit

• Amprobe Instruments GP-1 earth tester

• AEMC 3730 clamp-on ground resistance tester

The following is a list of recommended networking tools for installing and servicing the network:

• Fluke® OneTouch Assistant LAN tester

• NiMH rechargeable battery for Fluke

• T1/E1 or E1 test set (such as the Hewlett-Packard® HP37702A)

• Serialtest® software with ComProbe® and SerialBERT option

3.5.2

Base Radio Tools
The following is a list of tools required to install, optimize, and service the base radio equipment:

• Service Monitor: Aeroflex 3900 Series Service Monitor with P25 Options installed (plus HPD and
TDMA options as required)

• Service computer/laptop meeting the following specifications:

- Operating Systems:
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+ Windows 10 (Server 2012 R2)

• Hardware Requirements:

- Processor:

+ 1 GHz or higher Pentium grade

- Processor Memory:

+ 2 GB RAM recommended for Windows 10

- Hard Disk Space:

+ 300 MB minimum free space (for a Typical Installation, including Help Text and Software
Download Manager) or 100 MB minimum free space (for a Compact Installation)

- Peripherals:

+ Microsoft Windows supported Mouse or Trackball

+ Microsoft Windows supported Serial Port for product communication

+ Microsoft Windows supported Ethernet Port for product communication

+ Microsoft Windows supported Printer Port for report printing

+ CD-ROM for software installation

• Configuration/Service Software (CSS) DLN6455

• CSS Serial Programming Cable - 3080369E31

• Antenna tester

• 50 Ohm Terminated Load

• RohdeSchwarz NRT-Z14 Directional Power Sensor 25-1000 GHz 0.1-120W average reading
powermeter for use when R2670 service monitor is not available

• See “Quick Connect RF Coaxial Adapters for GTR 8000 Base Radio Support” in the GTR 8000
Expandable Site Subsystem manual for a list of RF connectors that may be used.

3.6

Power Requirements
All equipment at the site supports operation from 120/240 VAC nominal single phase power sources at
50/60 Hz. The GTR 8000 Base Radios, and racked subsystems also support operation from a 48 VDC
power source or battery. The GTR 8000 Expandable Site Subsystem can be supplied with up to six
120/240 VAC inputs and up to two separate branches of DC/battery input to the power supplies in the
rack.

The GTR 8000 Base Radio has automatic battery revert capabilities and can charge batteries from the
AC power supply. The power supply includes an integrated charging system that eliminates the need
for UPS and that provides battery equalization. For the GTR 8000 base radio platform, the integrated
distributed site rectifier provides 3A charging per power supply module. The battery charge and
temperature conditions are monitored by the base radio and may be viewed through CSS or through
alarms to Unified Event Manager.

The GTR 8000 Base Radio is able to provide 28.6 V auxiliary power outputs to another connected
device (GCP 8000 Site Controller or RMC) as a backup power source to allow the connected device
with a power supply failure to maintain continued operation. The GTR 8000 Expandable Site
Subsystem has an internal auxiliary power configuration for the site controller modules and RFDS
equipment.

Follow the guidelines in Standards and Guidelines for Communication Sites for information on
providing electrical service, power budgeting, selecting batteries, and other topics for supplying power
at the site.
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3.7

Site Router or Gateway
A site router or site gateway handles traffic between a remote site network and the link to the master
site. The router or gateway distributes network management traffic between the equipment in the site
network.

For detailed information on interfacing modules for a router or gateway, see the GGM 8000 System
Gateway or S6000 and S2500 System Routers manual.

3.8

Adding an HP2620-24 LAN Switch to an ASTRO 25 Repeater
Site
The addition of one or two HP2620-24 switches provide IP connectivity from the GGM 8000 Site
Gateway or S2500 Site Router to the QUANTAR® stations, GTR 8000 Base Radios, and GCP 8000
Site Controllers.

Prerequisites:
A certified configuration file for the HP2620-24 switch is required.

NOTICE: Configure port 20 as NTP_Server in the certified configuration for the addition of the
NTP Server.

Procedure:

1 Install the HP2620-24 switch. See the System LAN Switches manual.

2 Connect the Ethernet IP cable from the site gateway or site router to the HP2620-24 switch.

3 Connect the Ethernet IP cable from the HP2620-24 to the RF devices.

• Standalone GTR 8000 Base Radios: Connect the Ethernet IP cable to the SITE CTRL A
Ethernet port.

• Standalone QUANTAR® stations: Connect the Ethernet IP cable to Ethernet port 61.

• GCP 8000 Site Controller in a GTR 8000 Expandable Site Subsystem: Connect the
Ethernet IP cable to the Net AUX port on the junction panel.

• Standalone GCP 8000 Site Controller: Connect the Ethernet IP cable to the Net AUX port.

3.9

TRAK 9100 and TRAK 8835
For detailed information on installation, configuration, and cabling see the Simulcast Site Reference
manual.

3.9.1

TRAK 9100 Digital Distribution Module Output
There are various alternatives methods for providing Digital Distribution Module (DDM) output signals
to components at a site based on variety of considerations including: type of equipment at a site, type
of site, cost considerations, type of signal required, type of site configuration (standalone GTR 8000
Base Radios, QUANTAR® stations, and standalone GCP 8000 Site Controller configuration) and DDM
port availability. Depending on the type of output signal needed for the component, one method might
be to route each of the output signals from a single DDM using separate cables, each with a
terminating resistor at each component. Another method might be to “daisy-chain” the output signal
from a DDM port using a single cable with a terminating resistor at the last component in the “chain” of
components. Another alternative would be to use a combination of methods to meet performance,
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reliability and/or maintenance considerations for the site. Figure 32: TRAK 9100 SSR DDM –
Standalone Device Cabling on page 80 shows various methods that might be used to cable the
output of the TRAK 9100 SSR DDM.

NOTICE: The EXT FREQ REF input on the rear of the standalone GTR 8000 Base Radio, the
Port 30 input on the rear of the QUANTAR® station, and the 1PPS input on the site controller is
high impedance. An external termination is required to properly terminate the cable connected
to the input. A BNC "T" and a 50 Ohm BNC termination should be connected to the input to
terminate the cable. The TRAK 9100 SSR DDM Rev D or later supports one TRAK/GCP output
to drive up to 15 channels connected over a distance of not more than 25 meters. This type of
connection is called a “daisy-chain”. If the cable is “daisy-chained”, only the last device in the
chain has the termination.

The following figure shows one DDM providing support for the primary site controller, one DDM
providing support for a redundant site controller, one DDM providing four output signals to various site
components and finally one port on a DDM being “daisy-chained” to provide an output signal to various
site components.

Figure 32: TRAK 9100 SSR DDM – Standalone Device Cabling
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3.10

GTR 8000 Expandable Site Subsystem Junction Panels
The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices for the standard configuration. Cables provided by Motorola Solutions
include the specific connectors required by the junction panel on one end and the subsystem
equipment on the other end.
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See the GTR 8000 Expandable Site Subsystem manual for the junction panel figures and tables for
information on the 700/800/900/UHF R2 435–524 MHz and UHF R1 380–435 MHz/VHF 136–174 MHz
junction panel connections for both the prime and expansion cabinets in a GTR 8000 Expandable Site
Subsystem configuration.

NOTICE: For GTR 8000 Expandable Site Subsystem HPD Overlay Site junction panel
connections see the HPD Overlay System Infrastructure Manual.

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

3.11

RFDS Modules
The Radio Frequency Distribution System (RFDS) equipment included in your subsystem depends on
what options were purchased from Motorola Solutions. See the GTR 8000 Expandable Site Subsystem
and GTR 8000 Base Radio manuals for a list of all the RFDS equipment available.
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Chapter 4

Operation
This chapter details how the ASTRO® 25 repeater site performs once it is installed and operational on
your system.

4.1

Operational Modes
The operational modes for an ASTRO® 25 repeater site are the following:

• Wide Area Trunking

• Site Trunking

• Failsoft

• Site Off

• Conventional (add-on)

Wide Area Trunking
An ASTRO® 25 repeater site can remain in wide area trunking as long as the following resources
are available:

• One voice channel

• One control channel

• A site controller

• Connectivity through the GCP 8000 Site Controllers and/or Expansion Hubs

• A site router or site gateway

• An Ethernet LAN (depending on the configuration)

• A physical link between the subsystem and the zone core

• A logical path between the site router or gateway and the zone core IP equipment

If one of the GCP 8000 Site Controllers fails, the other maintains the system in wide area trunking.
If the site is in site trunking mode, the GCP 8000 Site Controller manages all site functions and call
processing.

If a GCP 8000 Site Controller switchover occurs while the subsystem is in wide area trunking state,
all active voice calls at the site continue without an interruption in service. No “in progress” voice
calls are lost on a GCP 8000 Site Controller switchover. The switchover is possible because the
active voice call states and databases of the active and standby GCP 8000 Site Controllers are
synchronized.

NOTICE: If the site is using dual links, a zone core interface link failure or a site router or
gateway, or dual switches failure has no effect on wide area operations since the remaining
site router or gateway or switch maintains the links. With a single router or switch
configuration, however, the subsystem enters site trunking mode if a zone core interface link
failure or a site router or gateway or switch failure occurs.

Site Trunking
Site trunking operation takes place when there is no physical or logical link between the site router
or gateway or switch and the zone core or zone controller in a Trunking Subsystem (Tsub).
Conditions required to maintain site trunking include:

• One voice channel
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• One control channel

• A site controller

• Connectivity through the Ethernet switch or switches.

There are brief site trunking periods before failover to a (Tsub) zone controller and before returning
to the zone core zone controller.

Site trunking can also be initiated from the diagnostic capability in the Unified Event Manager.

If a GCP 8000 Site Controller switchover occurs while the site is in the site trunking state, all active
calls at the site are transmission trunked.

Failsoft
Failsoft mode of operation takes place only when both site controllers fail, there are no operational
control channel capable base radio, or all voice channels are inoperative. Failsoft can also be
initiated from the diagnostic capability in the Unified Event Manager.

Site Off
Site Off is an operational mode that can be initiated from the diagnostic capability in the Unified
Event Manager. In this state, the subsystem is not available to the subscriber radios.

Conventional
Conventional operation does not interface to the trunked system but, uses the network for
configuration and fault reporting. Subscriber radios communicate radio-to-radio or can
communicate in a console interface configuration.
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Chapter 5

Configuration/Optimization
This chapter contains optimization procedures and recommended settings relating to the ASTRO® 25
repeater site.

5.1

Repeater Site Equipment
The ASTRO® 25 repeater site can include the following equipment:

• Network Transport Equipment

• All standalone GTR 8000 Base Radios, all QUANTAR® stations, or mix of both

• All GTR 8000 Expandable Site Subsystem cabinets/racks with or without QUANTAR® stations

• Telecommunications Network Server (TeNSr) channel bank, when conventional channels are used
(connected externally to the GTR 8000 Expandable Site Subsystem)

• GCP 8000 Site Controllers

• Expansion Hubs for all GTR 8000 Expandable Site Subsystems with more than one cabinet with
integrated or external standalone GCP 8000 Site Controllers

• The Site Router or Gateway

• The Ethernet LAN Switch

• Radio Frequency Distribution System (RFDS) as needed for every GTR 8000 Expandable Site
Subsystem cabinet. This can include:

- Preselectors (700/800 MHz and UHF R2 455–512 MHz only)

- Diplexer (for dual band sites) (700/800 MHz only)

- Duplexers (900 MHz only)

- Transmit Filters (700/800/900 MHz and UHF R2 450–509 MHz only)

- Site and/or Cabinet Receive Multicouplers/Low Noise Amplifiers (RMCs/LNAs) (700/800/900
MHz and UHF R2 450–509 MHz only)

- RMC Pass Through (UHF R1 380–435 MHz and VHF 136–174 MHz)

- Cavity Combiners (700/800 MHz and UHF R2 450–509 MHz only)

- Hybrid Combiners (900 MHz)

- Power Monitor Unit (UHF/VHF/900 MHz)

- Phasing harness (if both cabinets are same band) or diplexer extension cable (if the two
cabinets are different bands) (700/800 MHz only)

• Radio Frequency Distribution System (RFDS) as needed for every standalone GTR 8000 Base
Radio. This can include:

- Preselectors (700/800 MHz, UHF, and VHF)

- Transmit Filters (700/800 MHz)

- External Dual Circulators/Isolator Trays (700/800 MHz, UHF, and VHF)

- Duplexers (700/800 MHz, UHF, and VHF)

- Antenna Relay Module
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• Junction Panel (GTR 8000 Expandable Site Subsystem)

• TRAK 9100 or TRAK 8835

• MOSCAD NFM equipment, when used.

The term “GTR 8000 Expandable Site Subsystem” does not cover the wide area network (WAN)
microwave or fiber backbone equipment.

MOSCAD NFM equipment is optional at an ASTRO® 25 repeater site. However, this documentation
treats it as a standard feature to be installed with the original site.

If MOSCAD NFM equipment is going to be installed at the site, Motorola Solutions provides a
MOSCAD NFM site configuration file in the documentation.

5.2

HPD Site Configuration with Multiple Managers
The system infrastructure within the ASTRO® 25 system is configured, managed, and serviced by
using the Unified Network Configurator (UNC) server application, the Configuration/Service Software
(CSS), and Provisioning Manager (PM) applications. For the zone controller and Packet Data Gateway
(PDG) configurations, the common parameters are configured in both UNC and Provisioning Manager.

• CSS is used to program all parameters in the site controllers, comparators, and base radios. The
programming takes place at the time the equipment is installed at the site, and if network
connectivity from UNC server application to the site equipment is not operational.

• UNC is used to program parameters to the site devices, routers, zone controller, PDGs, and links.
Once the site is set up, UNC is the recommended configuration manager for the site equipment.
Use CSS only when the UNC-to-site equipment network link is not operational.

• Provisioning Manager is used to program system-level parameters for the zone controllers, PDGs,
consoles, conventional site controllers, and to set up sites and channels in the zone controller. Data
service-related parameters are programmed for the PDG.

For detailed configuration procedures, see the Provisioning Manager and Unified Network Configurator
manuals, and the CSS online help.

5.3

Port Link Connections
There are two ways to can make the port link connection to a GTR 8000 Expandable Site Subsystem,
or to the GTR 8000 Expandable Site Subsystem hardware components:

• Connecting Through an Ethernet Link

• Connecting Through a Serial Link

5.3.1

Security/Authentication Services

If the device supports SNMPv3 protocol, a pop-up dialog box appears displaying the SNMPv3
Password Prompt when logging in to a device through Configuration/Service Software (CSS) using an
Ethernet connection. For configuration details, see the Information Assurance Features Overview,
Software Download Manager, and SNMPv3 manuals. See Figure 33: SNMPv3 Security Level Option
Prompt on page 87.
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Figure 33: SNMPv3 Security Level Option Prompt

A pop-up window appears displaying the File Transfer Access Services for CSS. Use this logon when
communicating to a device through CSS using either an Ethernet or DB-9 Serial Port connection. See 
Figure 34: CSS Login Banner on page 87.

Figure 34: CSS Login Banner

5.3.2

Connecting Through an Ethernet Port Link

Prerequisites: Load Configuration/Service Software (CSS) on the service computer/laptop. See the
Private Network Management Client manual if necessary or see the instructions in the CSS DVD jewel
box for instructions on loading the CSS onto the service computer/laptop.
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When and where to use: Use the Ethernet port link to configure all CSS parameters for the device.

Procedure:

1 Connect a service computer/laptop to a device using one of the following methods:

NOTICE: Normally the service computer/laptop is connected through the local site switch
or remotely through the network. Do not connect directly to the Ethernet service port of
the device unless downloading software or individually configuring the device.

a Remote Connection to Network or Local Site Switch:

1 Connect remotely to the network or to the local site switch using a straight-through an
Ethernet straight-through Ethernet cable.

2 If connecting to the local site switch, configure the Ethernet interface of the service
computer/laptop to a Speed/Duplex setting of Auto-Negotiate. Set the IP address of the
service computer/laptop to an unused IP address on the subnet of the local site. The IP
address on the subnet varies depending on the site and zone numbers.

b Direct Connection to Front Ethernet Service Port:

1 Connect directly to the front panel Ethernet service port with a straight-through Ethernet
cable.

2 If connecting to a base radio or receiver, set the IP address of the service computer/laptop
to 192.168.x, where x is any number between 2 and 253.

3 If connecting to a site controller or reference distribution module, set the IP address of the
service computer/laptop to an unused IP address on the subnet of the local site. The IP
address on the subnet varies depending on the site and zone numbers.

4 Configure the Ethernet interface of the service computer/laptop to a Speed/Duplex setting
of Auto-Negotiate

NOTICE: The comparator does not support a direct connection to the front panel
Ethernet service port. The connection must be done remotely through the network or
through the local site switch.

2 Open the CSS application.

3 From the menu, select Tools → Connection Configuration.

4 From the Connection Screen, in the Connection Type area, select Ethernet.

5 If connected directly to the front panel Ethernet service port of a base radio or receiver, click
Front Panel Ethernet and go to step 7.

6 Perform one of the following actions:

If… Then…

If you know the IP
address for the de-
vice,

perform the following actions:

a In the Device IP Address field, enter the IP address for the de-
vice.

b Click Connect.

c Go to step 7.

Trunked Device: If
you do not know
the IP address, but
know the system
identification of the
device (the zone,

perform the following actions:

a Click Device Name Wizard to open the Device Name Wizard
dialog box.

b From the Device drop-down list, select the relevant device type.
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If… Then…

physical site, sub-
site, and device ID
of the device),

c In the Zone, Physical Site, Subsite, and Device ID fields, enter
the proper values.

NOTICE: Some fields, such as Subsite, do not allow
entries for some devices. Therefore, select the device
first.

d Click OK.
The Domain Name Services (DNS) information of the device au-
tomatically appears in the Device IP Address field.

e Click Connect.

f Go to step 7.

Conventional De-
vice: If you do not
know the IP ad-
dress,

perform the following actions:

a Establish a serial connection to the device. See Connecting
Through a Serial Port Link on page 90.

b For a base radio, receiver, or comparator, from the menu, select
Tools → Set IP Address/BR_CM Pairing Number. For a site
controller or reference distribution module, select Set IP Ad-
dress/Box Number.

c In the Device IP Address field, record the IP address.

d Re-establish an Ethernet connection and repeat steps 1 through
4.

e In the Device IP Address field, enter the IP address for the de-
vice.

f Go to step 7.

7 To make the connection, click Connect.

If this device is SNMPv3-capable, the SNMPv3 Passphrase Prompt dialog box appears.
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Figure 35: SNMPv3 Passphrase Prompt

8 In the SNMPv3 Passphrase Prompt dialog box, enter the User Information and Passphrase
Information. Click OK. If Authentication Services are not enabled on a device, click OK when
the dialog box appears.

9 From the menu, select File → Read Configuration From Device.

The parameters download from the device to the service computer/laptop. When the download
is complete, the CSS main window opens. Use the map on the left side of the screen to view
configuration information for the device.

5.3.3

Connecting Through a Serial Port Link

Prerequisites: This procedure assumes that the Configuration/Service Software (CSS) application is
loaded on your service computer/laptop. See the Private Network Management Client manual.

When and where to use: This procedure describes the steps required to connect through a serial port
link to set the IP address of the device and to set the serial security services. Perform all other device
function and feature configurations through an Ethernet port connection in the CSS.

Procedure:

1 Connect a serial cable to a service computer/laptop running CSS, and the serial connector on
the device module. The serial cable is an RS232, female DB-9 to male DB-9 straight through
cable. If the service computer/laptop does not have a serial port, use a USB-to-serial converter
external device.

2 Open the CSS application.

3 From the menu, select Tools → Connection Configuration.

The Connection Screen dialog box appears.
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4 In the Connection Type area, select Serial.

The Serial Settings area on the dialog box becomes enabled.

5 In the Serial Port field, select the communication port that matches the one selected on the
service computer/laptop.

6 In the Baud Rate field, select the baud rate with which you want to communicate with the
device.

• Baud Rate 19200

7 Click Connect.

A login/password prompt screen appears.

Figure 36: CSS Login Banner

8 Provide the required credentials. Perform one of the following actions:

• If a domain controller is available on the network, enter the Username and Password for the
RADIUS service user account assigned to the netwadm group in the Active Directory. (The
default service user is serviceuser.)

• If a domain controller is not available on the network, enter the Username and Password for
the local bts_service account.

• If the Elevated Privileges Password field is active, enter the Elevated Privileges
Password that was set up for this device.

When accessing the device, if the default passwords do not work, the passwords may have
been set to default values by a different system release of software. See "Resetting Device
Passwords" in the CSS Online Help to reset the passwords to the current software release
defaults. If Authentication Services are not enabled on a device, type any alphanumeric
characters to populate the [Username, Password, and Elevated Privileges Password] fields,
as they cannot be left blank.

9 To access the device and close the dialog box, click OK.

The blank CSS main window appears.

NOTICE: The Service menu is not available until you read the configuration file from the
device using an Ethernet connection.
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5.4

Configuring a Site
Follow this process to configure the equipment at a site.

Use the as-built documentation of your system as your programming aid to ensure that you program
the devices to a known baseline. The as-built documentation outlines programming for the IV&D and
HPD overlay equipment and provides the settings for all parameters of the devices at the site.
Configuration/Service Software (CSS) default settings provide typical values that are suitable for many
sites.

WARNING: An HPD GCP 8000 Site Controller switch configuration must be set up properly
before plugging an HPD site into the IV&D site network. If an HPD GCP 8000 Site Controller is
installed at a site with two Ethernet switches or two GCP 8000 Site Controllers, the redundant
switch connection (port 20) must be disabled for each HPD GCP 8000 Site Controller. Disable
the connection (port 20) through CSS to prevent a network loop at the site.

IMPORTANT: Do not deviate from specified settings without following the proper change
procedures for your organization. If a problem due to programming arises, not following proper
change procedures makes troubleshooting more difficult.

Prerequisites: Locate the IP address and physical address for each of the GTR 8000 Base Radios
and GCP 8000 Site Controller modules before performing this process. Contact your system
administrator for this information.

Process:

1 Transfer and install software to the equipment at the remote site by using Software Download
Manager.

NOTICE: All software is installed by Motorola Solutions before shipping the equipment to
the intended installation site. SWDL Manager is used to transfer and install software
updates to devices in the remote site as needed.

2 The following records must be created and configured in Provisioning Manager (PM) at each site
for the zone controller:

• Sites

• Channels

3 Set the IP address and physical address for each of the GTR 8000 Base Radios and GCP 8000
Site Controller modules by using a direct serial connection with CSS.

4 Use the Unified Network Configurator Wizard to:

• Discover devices.

• Upload configurations for the devices.

• Generate changes for non-compliant devices.

• Approve jobs (if any).

5 Configure the GCP 8000 Site Controller settings through CSS. See: Configuring the GCP 8000
Site Controller Settings Through CSS on page 93.

6 Configure the GTR 8000 Base Radio settings through CSS. See: Configuring the GTR 8000
Base Radio Settings Through CSS on page 93.
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5.4.1

Configuring the GCP 8000 Site Controller Settings Through CSS
For detailed configuration procedures about the GCP 8000 Site Controller by using Configuration/
Service Software (CSS), see the GCP 8000 Site Controller manual and the CSS Online Help.

Prerequisites: Perform Configuring a Site on page 92.

Procedure:

1 Connect Configuration/Service Software (CSS) with the active GCP 8000 Site Controller through
an Ethernet connection.

2 Configure the channels, band plan, and switch settings. If the site has two Ethernet site switches
or two GCP 8000 Site Controllers, then for HPD overlay, both HPD GCP 8000 Site Controllers
are connected to the LAN. In this case, the redundant switch connection (port 20) in each HPD
GCP 8000 Site Controller must be disabled through CSS to prevent a network loop. If the site
only has one Ethernet switch (and only one HPD GCP 8000 Site Controller connected to the
LAN), then the switch connection (port 20) must be enabled through CSS. This must be done
before connecting the HPD GCP 8000 Site Controllers to the ASTRO® 25 repeater site LAN.

3 Write the data to the GCP 8000 Site Controller.

4 Check the status report and status panel to verify that the GCP 8000 Site Controller and its
components are operating properly.

5 Check the Global Navigation Satellite System (GNSS) information screen and verify the values.
Press the Refresh button to get current GNSS values.

6 Through a serial connection, initiate the battery equalization for the GCP 8000 Site Controller by
using CSS.

7 Reset the active GCP 8000 Site Controller so the other GCP 8000 Site Controller becomes
active. For HPD overlay, do the same for the active HPD GCP 8000 Site Controller.

8 Configure the newly active GCP 8000 Site Controller in the same manner. For HPD overlay, do
the same for the newly active HPD GCP 8000 Site Controller.

5.4.2

Configuring the GTR 8000 Base Radio Settings Through CSS
For detailed configuration procedures about the GTR 8000 Base Radio by using Configuration/Service
Software (CSS), see the GTR 8000 Base Radio manual and the CSS Online Help.

Prerequisites: Perform Configuring a Site on page 92.

Procedure:

1 Connect Configuration/Service Software (CSS) with the GTR 8000 Base Radio through an
Ethernet connection.

2 Configure the GTR 8000 Base Radio settings, including the transmit/receive frequencies, band
plan settings, battery type, and GTR 8000 configuration (standalone, site subsystem, or
expandable site subsystem).

3 If the GTR 8000 Base Radio is in a site subsystem or GTR 8000 Expandable Site Subsystem
rack, set the attenuation on the receive multicouplers (RMCs) according to the values in the
Receive Multicoupler (RMC) Configuration tab.

4 Press the Validate HW Configuration button to verify that the hardware configuration is valid. A
success or error message is displayed.

5 Change the mode from Configuration mode into Normal mode.

6 Write the data to the GTR 8000 Base Radio.
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7 Check the status report and status panel to verify that the GTR 8000 Base Radio and its
components are operating properly.

8 Initiate a battery alignment in CSS.

9 Set the GTR 8000 Base Radio to Service mode.

10 Initiate tests and measurements for BER and RSSI by using either IV&D or HPD patterns
(connect with a service monitor).

11 Set the GTR 8000 Base Radio with the appropriate channel number through CSS.

12 Set the date and time through CSS.

5.5

Software Download Manager

The Software Download Manager (SWDL) is an application that can transfer only, install only, or
transfer and install new software to devices. The new software can be installed either locally at a site or
on the Network Management subsystem. Individual devices not connected to the system can be
downloaded using single device mode.

NOTICE: Throughout this manual, the name SWDL is used to refer to the Software Download
Manager application.

Software Download Security Transfer Modes
A software download can be performed using the following security transfer modes:

Clear SWDL
Transfers the software without security, based on the File-Transfer Protocol (FTP)

Secure SWDL
Transfers the software as encrypted, based on the Secure File-Transfer Protocol (SFTP)

NOTICE: All secure sequential and simultaneous transfers use the Diffie-Hellman group
exchange. The Diffie-Hellman group exchange is used for devices supporting Diffie-Hellman
group exchange. The Diffie-Hellman group exchange enhances the security of Secure Shell
(SSH) protocol initial key exchange. See the Software Download Manager manual for details.

Before initiating transfer, SWDL connects to the site in the zone to discover all devices. The transfer
mode of all devices is displayed in the SWDL window. It is important that all devices have the same
SWDL transfer mode. Otherwise, SWDL flags a mismatch of the SWDL transfer modes across site
devices.

SWDL provisions the credentials for Secure SWDL as part of initiating the SWDL operation. No user
intervention is required. For a single device, Secure or Clear SWDL is configured based on the SWDL
Transfer Mode configuration within the Configuration/Service Software (CSS). The Unified Network
Configurator (UNC) can be used to schedule and configure all devices in the system at once.

For information on how to configure the secure or clear SWDL transfer mode, see the Unified Network
Configurator manual and “Device Security Configuration” in the CSS Online Help.

Software Download Transfer Methods
A software download can be accomplished in two ways:

Site Software Download
Allows you to transfer and install application software from any location within a network. The
Software Download Manager resides on the Network Management Client computer and a service
computer/laptop loaded with the CSS application. From either of the computers, you can select
device types to download software. Site Software Download allows you to select the zone, site,
device types, and software download operation to perform. When performing a site software
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download, the site controller coordinates the software transfer for all trunked base radios, receivers,
comparators, and reference distribution modules installed at the site. A site software download can
only be performed on a trunked ASTRO® 25 system.

NOTICE: Trunked GPW 8000 Receivers in a circuit simulcast configuration are not
supported using a site software download.

Single Device Software Download
Allows you to transfer and install software to a single instance of a device (such as one base radio).
This feature gives the technician the ability to install different versions of software. Single device
software download is done from a service computer/laptop loaded with the CSS application either
connected directly to the device or connected to the network.

NOTICE: Conventional devices and 3600 base radios are supported only in single device
software download.

Site Software Download Functionality
When SWDL is connected from a central remote location, SWDL performs a site software download to
the site controllers, then to the comparators and base radios or receivers installed at the site. Both
active and standby site controller modules have two flash memory banks for storing software. The
device application is run from RAM, and is loaded from the active flash memory bank after a reset. One
bank is active while the other bank is inactive. The transfer of the software using SWDL is a
background process, without interruption of services at the site, that loads the software into the inactive
bank. The site controller executes the software from one bank, while software is simultaneously
downloaded to the inactive bank. The transfer and install are done in the background. An install causes
the site controller to reset and load the RAM from the bank that was installed with the new software.

NOTICE: For geographically redundant prime sites, a site software download should not be
attempted while the third Site Controller (SC3) is in the active state.

SWDL communicates with the site controllers to determine the number of existing remote sites and the
number of channels. SWDL considers a channel or remote site to be accessible if its status is “Not
Unconfigured.” This term means that the site must be set up with a service computer/laptop with CSS
or a network management client before software download is performed on the site.

The system downloads software to the site controllers, comparators, base radios, or receivers as a
unit. Use SWDL to transfer software to each device type, then perform an install operation. During the
transfer, the operation designates a proxy for each device type at each LAN. Site controllers proxy for
comparators, and base radios or receivers proxy for each other. The proxy cross-transfers the software
to other devices on the LAN. Using proxies minimizes system downtime. Transfers to the LAN are
done simultaneously except for the site controller and comparators.

Software installation is done on a channel-by-channel basis, starting with the highest number channel.
When a channel software download occurs, the base radio or receiver which incorporates that channel
is processed along with the comparator for that channel. For example, if channel 3 was being
downloaded, comparator 3 and the base radios or receivers for channel 3 at each of the remote sites
would be installed simultaneously.

SWDL operation can be fault managed through Unified Event Manager (UEM), syslog, local SWDL log
files, user messages, and device reports.

For further information on SWDL, see the Software Download Manager manual.

The operating software can also be loaded using the UNC. See the Unified Network Configurator
manual to perform single device software downloads (ruthless download) to the devices.

See the G-Series Equipment System Release Setup Guide manual for SWDL instructions specific to
the operating characteristics of your existing system release.
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5.6

GTR 8000 Expandable Site Subsystem Adding Channels
(700/800/900 MHz)
The GTR 8000 Expandable Site Subsystem configuration can be ordered with two to six base radios
for the primary cabinet, one to six base radios per expansion cabinet, and two to five base radios for an
HPD overlay cabinet. Any open slots can be filled at a later date depending upon how many slots are
open and how many base radios you want to add.

To add 700 MHz base radios to an 800 MHz GTR 8000 Expandable Site Subsystem or 800 MHz base
radios to a 700 MHz GTR 8000 Expandable Site Subsystem you must add another cabinet containing
the other band base radios. This cabinet must be connected to the existing cabinet with a diplexer
extension cable (the cabinets must not be more than one in. apart). In this situation a diplexer is used
instead of a transmit filter to combine the transmitters of the two cabinets. The diplexer is only installed
in the cabinet which connects to the antenna. The diplexer can be located either in the cabinet with the
700 MHz base radios or the cabinet with the 800 MHz base radios. You must add at least two base
radios when adding in another band.

To add base radios in the same frequency band, you can add from one to four base radios to a cabinet
with open slots or you can add another cabinet with at least two base radios. The cabinets in the same
band must be connected with a phasing harness (700/800 MHz only the cabinets must not be more
than one in. apart). For an ASTRO® 25 repeater site, you can have up to a maximum of 28 channels.

IMPORTANT:

• If you are adding a cabinet or cabinets with 700 MHz base radios to an existing 800 MHz
GTR 8000 Expandable Site Subsystem, you should check your band plan configurations.
You may need to update the Provisioning Manager information.

• When you add new base radios, you must load them with the same version of the software
currently running at the site. You cannot mix software versions.

• A cavity combiner must be tuned to the correct transmit frequency.

5.7

GTR 8000 Expandable Site Subsystem Adding Channels for
UHF R1 (380–435 MHz)
The GTR 8000 Expandable Site Subsystem configuration can be ordered with up to six base radios for
the primary cabinet, one to six base radios per expansion cabinet, and two to five base radios for an
HPD overlay cabinet. Any open slots can be filled at a later date by adding additional base radios,
depending upon how many slots are open and how many base radios you want to add. For an
ASTRO® 25 repeater site, you can have up to a maximum of 28 channels.

IMPORTANT:

• If you are adding a cabinet or cabinets with UHF R1 (380–435 MHz) base radios to an
existing UHF R1 (380–435 MHz) GTR 8000 Expandable Site Subsystem, you should check
your band plan configurations. You may need to update the Provisioning Manager
information.

• When you add new base radios, you must load them with the same version of the software
currently running at the site. You can not mix software versions.
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5.8

GTR 8000 Expandable Site Subsystem Adding Channels for
UHF R2 (435–524 MHz)
The GTR 8000 Expandable Site Subsystem configuration can be ordered with up to six base radios for
the primary cabinet, one to six base radios per expansion cabinet, and two to five base radios for an
HPD overlay cabinet. Any open slots can be filled at a later date by adding additional base radios,
depending upon how many slots are open and how many base radios you want to add. For an
ASTRO® 25 repeater site, you can have up to a maximum of 28 channels in a GTR 8000 Expandable
Site Subsystem.

IMPORTANT:

• If you are adding a cabinet or cabinets with UHF R2 (435–524 MHz) base radios to an
existing UHF R2 (435–524 MHz) GTR 8000 Expandable Site Subsystem, you should check
your band plan configurations. You may need to update the Provisioning Manager
information.

• When you add new base radios, you must load them with the same version of the software
currently running at the site. You cannot mix software versions.

• A cavity combiner must be tuned to the correct transmit frequency.

5.9

GTR 8000 Expandable Site Subsystem Adding Channels for
VHF (136–174 MHz)
The GTR 8000 Expandable Site Subsystem configuration can be ordered with up to six base radios for
the primary cabinet, one to six base radios per expansion cabinet, and two to five base radios for an
HPD overlay cabinet. Any open slots can be filled at a later date by adding additional base radios,
depending upon how many slots are open and how many base radios you want to add. For an
ASTRO® 25 repeater site, you can have up to a maximum of 28 channels in a GTR 8000 Expandable
Site Subsystem.

IMPORTANT:

• If you are adding a cabinet or cabinets with VHF (136–174 MHz) base radios to an existing
VHF (136–174 MHz) GTR 8000 Expandable Site Subsystem, you should check your band
plan configurations. You may need to update the Provisioning Manager, CSS, and Unified
Network Configurator information.

• When you add new base radios, you must load them with the same version of the software
currently running at the site. You can not mix software versions.

5.10

Configurations
When configuring Network Security for channels, the GCP 8000 Site Controllers and GTR 8000 Base
Radios must be operating with either the SNMPv1 or SNMPv3 configuration files. See the Software
Download Manager, Information Assurance Features Overview, MAC Port Lockdown, and SNMPv3
manuals for further configuration details.

NOTICE: If QUANTAR® stations are mixed with GCP 8000 Site Controllers and GTR 8000
Base Radios, SNMPv1 and clear SWDL support must be used for the site devices at the site.

For information on configuring the GTR 8000 Base Radios, QUANTAR® stations, and GCP 8000 Site
Controllers, see the CSS Online Help.

MN003231A01-A
Chapter 5:  Configuration/Optimization

Motorola Solutions Confidential

Send Feedback   97

http://docsurvey.motorolasolutions.com


5.11

Performance Optimization
Once the site equipment is installed and configured, you must optimize the performance of the site.
See the Optimization chapter in the GTR 8000 Expandable Site Subsystem, GTR 8000 Base Radio,
QUANTAR Instruction Manual (6881095E05), and GCP 8000 Site Controller manuals for detailed
optimization procedures.

Your Motorola Solutions Field Representative or Motorola Solutions Support Center (SSC) can advise
you on optimization activities required for your system, if any. See Motorola Solutions Support Center
Contact Information on page 106.
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Chapter 6

ASTRO 25 Repeater Site with HPD
Overlay Feature Expansion
This chapter provides the system-wide feature expansion information necessary to add HPD overlay to
an existing site.

6.1

Bandwidth Requirements
Since the HPD overlay equipment shares bandwidth on the site link, consider the total amount of
bandwidth on the site link. An ASTRO® 25 repeater site does not exceed more than a full T1/E1 link.
However, if an existing site is using a fractional T1/E1 site link, then supply the proper amount of
bandwidth to support the ASTRO® 25 repeater site equipment, HPD overlay equipment, and any
conventional channels supported at the site.

The HPD overlay equipment requires one DS0 of site link bandwidth per HPD channel at the site (with
a minimum of two DS0s). So, add a total of 2-5 DS0s to the site link bandwidth calculation for the HPD
overlay equipment. For additional information on calculating bandwidth requirements, see the Console
Site Bandwidth Management manual.
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Chapter 7

Troubleshooting
This chapter provides fault management and troubleshooting information relating to the ASTRO® 25
repeater site.

Before troubleshooting an ASTRO® 25 repeater site you must understand:

• The relation between the zone core and the ASTRO® 25 repeater site.

• Various call-processing scenarios.

• How packets flow through the system.

• Equipment operational theory.

• Communications links to all sites.

7.1

Troubleshooting Tools 
The overall methodology for diagnosing and troubleshooting an ASTRO® 25 repeater site includes:

• Using software and hardware tools to monitor links and the individual devices that comprise an
ASTRO® 25 repeater site.

• Isolating problems to a FRU level and correcting them.

Table 5: Software Tools for Troubleshooting on page 101 identifies the tools you can use to
troubleshoot individual links and components.

Table 5: Software Tools for Troubleshooting

You can use this tool To Diagnose

Unified Event Manager • Site Links

• GCP 8000 Site Controller

• GTR 8000 Base Radio

• TRAK 9100 or TRAK 8835

• Ethernet LAN Switches

• Microwave antenna equipment (through point-to-point devices)

MOSCAD Network Fault
Management

• GTR 8000 Base Radio

• QUANTAR® station

• GCP 8000 Site Controller

• TRAK 9100 or TRAK 8835

• Microwave Links

• RFDS – Tower Top Amplifier (via the digital input lines of the SDM
3000)

• RFDS – Receiver Multi-coupler

• Hybrid Combiner

Table continued…
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You can use this tool To Diagnose

Configuration/Service
Software (CSS)

• GCP 8000 Site Controller

• GTR 8000 Base Radio

• QUANTAR® station

• Antenna Relay Module

Unified Network Configu-
rator (UNC)

• GCP 8000 Site Controller

• GTR 8000 Base Radio

• Routers or Gateways

• Ethernet LAN Switches

• Channels

• Remote Site

• Antenna Relay Module

ZoneWatch • Channels

LED indicators and physi-
cal connections

• GCP 8000 Site Controller

• GTR 8000 Base Radio

• QUANTAR® station

• TRAK 9100 or TRAK 8835

• Routers or Gateways

• Ethernet LAN Switches

• Hybrid Combiners

Command line diagnostics • Routers or Gateways

• Ethernet LAN Switches

• TRAK 9100 or TRAK 8835

Terminal Server (at the
site)

• GCP 8000 Site Controller

• GTR 8000 Base Radio

• QUANTAR® station

• Routers or Gateways

• Ethernet LAN Switches

NOTICE: For additional information on troubleshooting and management of the Active Directory
(AD) service, Remote Authentication Dial-In User Service (RADIUS), and Domain Name
Service (DNS) at an ASTRO® 25 repeater site, see the Authentication Service manual.

MN003231A01-A
Chapter 7:  Troubleshooting

Motorola Solutions Confidential

102  Send Feedback

http://docsurvey.motorolasolutions.com


7.2

Troubleshooting Methodology
When and where to use: This process describes a methodology you can use to isolate faults to the
FRU level.

Process:

1 Regularly monitor links using Unified Event Manager and individual components using Unified
Event Manager topology maps. Check manager links, site control paths, and infrastructure links
for the site. Also check the condition of any microwave equipment, if applicable, through the
Supported Systems root level container in Unified Event Manager.

2 Analyze Unified Event Manager Active Alarms Windows, on a regularly-scheduled basis. Look
for patterns in alarms and alerts that may aid in isolating a fault.

3 Use other tools listed in “Troubleshooting Tools ” to isolate a fault after initial alarm from Unified
Event Manager. Refer to the remaining sections of this chapter for more details.

4 Escalate the problem if you cannot isolate faults.

7.2.1

Monitoring Links and Components in Unified Event Manager
Unified Event Manager is a tool used to monitor links and components of the ASTRO® 25 repeater site.
Monitoring may take place remotely from a central operations center. Two types of monitoring include:

• Real-time monitoring of Unified Event Manager Topology Maps, which alert you to faults as they
occur.

• Evaluation of Unified Event Manager Active Alarms Window on a regularly scheduled basis.

See the UEM Online Help for further details.

7.2.2

Analyzing Unified Event Manager Active Alarms Window
The Unified Event Manager Active Alarms Window is useful for troubleshooting because it captures
alarms that may occur intermittently or during off-hours. For example, you can review the Active
Alarms Window to correlate reported loss of service with patterns of critical alarms for links and
equipment.

When analyzing the Active Alarms Window, look for these types of patterns:

• Failures sent with time stamps on or about the same time.

• Failures from equipment attached to particular links. For example, routers, switches, site controllers,
and base radios.

• Many devices are capable of sending out events that report both critical and noncritical events.
Learn to distinguish between critical and noncritical events.

Refer to the UEM Online Help for further details.

7.2.2.1

Point-to-Point Components
The ASTRO® 25 repeater site can be set up to provide a way for the Unified Event Manager to fault
manage microwave antenna equipment by implementing PTP devices (Motorola Solutions Wireless
Bridges) at the site. See the Fault Management Reference Guide and Unified Event Manager manuals
for details.
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7.3

Troubleshooting the Repeater Site Link
Link failure between the zone core or zone controller in a Trunking Subsystem (Tsub) and the ASTRO®

25 repeater site is the most probable cause for site trunking at the site. Typical causes for link failure
are:

• Faulty or failed one or two site routers or gateways

• Faulty or failed Ethernet LAN switches

• Improper configuration (hardware and software)

• Interference due to extreme weather conditions

• Intermittent loss of carrier service

• Microwave equipment failure

• Physical obstructions in communications paths (for example, buildings, trees, and trains)

• Physical damage to copper or fiber optic lines

The following is a list of possible indicators of link failure in an ASTRO® 25 repeater site:

• The subscriber radio displays a “Site Trunking” indicator

• Alarms in Unified Event Manager Topology Maps and Active Alarms Window indicating that specific
links have failed

• LEDs on equipment to which links attach

7.3.1

Defining the Link
A link is defined as both the physical and logical connections between two entities. Table 6: System
Repeater Site Link Description on page 104 provides a detailed description of the link used between a
typical ASTRO® 25 repeater site and the zone core or zone controller in a Trunking Subsystem (Tsub).

Table 6: System Repeater Site Link Description

Link Name Physical Description Logical Description

Site Link Connects the zone core or (Tsub) and the
ASTRO® 25 repeater site.
In an ASTRO® 25 system multizone sys-
tem, the link is a fractional T1 (FT1) or T1
between the WAN switch at the zone core
and the site router or gateway. Bandwidth
may range from 384K to 1.536 Mbps, de-
pending on the number of channels on
your system.

In an ASTRO® 25 system (Tsub), the link
is Ethernet between the WAN switch and
the site router or gateway.

Provides the physical link and connec-
tion between the redundant core rout-
ers at the zone core and the site rout-
er or gateway.
The logical connection between the
two sites is set up through configura-
tion. Logical path is through redundant
frame relay PVCs. Control traffic uses
both PVCs. All other traffic, including
audio, uses one of the PVCs.

In an ASTRO® 25 system (Tsub), the
logical path is through Ethernet back-
haul switches.
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7.3.2

Troubleshooting Tools for the Link
Table 7: Recommended Troubleshooting Tools for an ASTRO 25 Repeater Site Link on page 105 lists
the recommended tools for troubleshooting an ASTRO® repeater site link to the zone core.

Table 7: Recommended Troubleshooting Tools for an ASTRO 25 Repeater Site Link

From This
Location

Using This Tool: See: Used To:

Remote Unified Event
Manager

Monitoring Links and Compo-
nents in Unified Event Manag-
er.

Evaluate/interpret real-time
and archived alarms. Use
Unified Event Manager to
monitor critical links and
components at the ends of
the links in the system.

Unified Network
Configurator
(UNC)

Troubleshooting in Unified
Network Configurator.

Verify and change configu-
rations for the RF devices,
zone controller and Package
Data Gateway (PDG). Use
the UNC to verify that con-
figurations for the devices at
the ends of the link, sites,
and channels have not
changed and the equipment
is active.

Local Visual inspection
of Equipment
LEDs and cables

Sections in this chapter that
discuss devices that interface
with the site link.

Verify proper configuration
and operation at the equip-
ment.

NOTICE: “Remote” in Table 7: Recommended Troubleshooting Tools for an ASTRO 25
Repeater Site Link on page 105 means that you are not at the ASTRO® 25 repeater site, but
are performing diagnostics from another location. “Local” means that you are physically present
at the site.

7.3.3

Troubleshooting in Unified Network Configurator
The Unified Network Configurator (UNC) is primarily a configuration tool that you use to configure
routers, switches, RF equipment, zone controller, and Package Data Gateway (PDG) during system
commissioning and later when you maintain or expand the system. Use the UNC to verify that
configurations for site equipment at each end of a link, and for sites and channels at the zone controller
and PDG have not changed and the equipment is active.

See the Unified Network Configurator manual for detailed procedures.

7.4

Troubleshooting Repeater Site Components
See the following manuals for additional information for troubleshooting individual components at an
ASTRO® 25 repeater site:

• SS6000 and S2500 System Routers or GGM 8000 System Gateway

• System LAN Switches
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• Simulcast Site Reference (TRAK 9100 and TRAK 8835)

• GTR 8000 Expandable Site Subsystem

• GTR 8000 Base Radio

• GCP 8000 Site Controller

• QUANTAR Instruction Manual (6881095E05)

7.5

Motorola Solutions Support Center Contact Information
The Motorola Solutions Support Center (SSC) provides technical support, Return Material
Authorization (RMA) numbers for FRUs and FREs, and confirmations for troubleshooting results. Call
the Motorola Solutions Support Center (SSC) for information about returning faulty equipment or
ordering advance exchanges.

North America: 1-800-221-7144
International: 302–444–9842
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Appendix A

Replacement of a Trunked QUANTAR
with a GTR 8000 Base Radio
This appendix provides general information related to the replacement of one or more trunked
QUANTAR® stations with GTR 8000 Base Radios or GTR 8000 Expandable Site Subsystem cabinets
in an ASTRO® 25 repeater site.

A.1

Compliance and Safety Considerations
IMPORTANT: Before performing a base radio replacement, verify and follow all safety, training,
and certification requirements and considerations.

Make sure to follow the R56 standards and guidelines for communication sites, including all safety
requirements and considerations. See the Standards and Guidelines for Communication Sites manual.
The Motorola Online (MOL) website contains additional information. For more details, log on to https://
motonline.mot-solutions.com and click Resource Center.

A.1.1

R56 Compliance Audit

Table 8: R56 Compliance Audit

Activity Description Reference

R56 Compliance The site should meet R56
standards and an ETA certi-
fied R56 auditor must verify
compliance.

See the following manuals:

• Standards and Guidelines for Communi-
cation Sites

• R56 Compliance Checklist and the R56
Audit Form in Standards and Guidelines
for Communication Sites

A.1.2

Hardware Installation and Optimization
The following table covers the references to the information required for site preparation:

Table 9: Hardware Installation and Optimization

Activity Description Reference

Equipment Re-
placement and
Configuration

Covers the equipment re-
placement and configura-
tion procedures which must
be performed at the site.

Replacement of a QUANTAR Station with a
Standalone GTR 8000 Base Radio or GTR
8000 Expandable Site Subsystem on page
117

Adding LAN
Switches

Covers the addition of LAN
switches to allow for con-
nectivity of channels.

Adding an HP2620-24 LAN Switch to an AS-
TRO 25 Repeater Site on page 79

Table continued…
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Activity Description Reference

Optimization and
Troubleshooting

Covers the equipment test
and verification procedures
which must be performed at
the site.

Alignment and Equalization Procedures on
page 129

A.2

QUANTAR Features Supported in the GTR 8000 Base Radio
The following table lists the QUANTAR® station features supported in the GTR 8000 Base Radio:

Table 10: QUANTAR Features Supported in the GTR 8000 Base Radio

QUANTAR Feature/Functionality Trunked GTR 8000 Base Radio Support

Voice Receive and Transmit (ASTRO) –
CAI C4FM

Channel parameters, output power, etc

Base Station Identification - FCC Morse
code ID

External Frequency Reference Capability

Internal Frequency Reference support

Battery backup - 48 or 60 VDC (48 VDC)

Infrastructure Interface

4-wire

V.24 only and V.24 Hybrid

Service Features

Station Status Panel

Station Log (Alarms and Events)

ASTRO BER and RSSI

ASTRO Test Pattern Transmission

Hardware Metering screens

HW and SW version screens

Software Download

Standalone and Expandable Site Subsys-
tem Hardware

Alignments

Options and Configurations

Option Description
Suppor-

ted
Option Description

— Monitor before Data Transmit Standard Receive Monitor

Table continued…
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QUANTAR Feature/Functionality Trunked GTR 8000 Base Radio Support

X889 V.24 Interface Standard V.24 Interface

— not supported Standard IP Interface

A.3

Performance Specifications
The performance specifications for the QUANTAR® station have been included in this section for
convenience. For related G-Series performance specifications, see G-Series Related Performance
Specifications on page 112 for details.

NOTICE: The performance specifications listed in this section are not specific to this guide, but
are valid for all applications.

A.3.1

General – QUANTAR
The following table lists the general performance specifications for the QUANTAR® station:

Table 11: General Performance Specifications – QUANTAR

Item Description

TX Sub-Band Range VHF
132-154 MHz (R1)
150-174 MHz (R2)

UHF
380-433 MHz
(R0)
403-433 MHz
(R1)
438-470 MHz
(R2)
470-494 MHz
(R3)
494-520 MHz
(R4)

800
851-870
MHz

900
935–941
MHz

RX Sub-Band Range VHF
132-154 MHz (R1)
150-174 MHz (R2)

UHF
380-433 MHz
(R0)
403-433 MHz
(R1)
438-470 MHz
(R2)
470-494 MHz
(R3)
494-520 MHz
(R4)

800
806-825
MHz

900
896–902
MHz

Channel Spacing VHF
30, 25, 12.5 kHz

800
12.5, 25 kHz

800
12.5, 25 kHz

900
12.5 kHz

Frequency Generation Synthesized

Power Supply Type Switching
Table continued…
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Item Description

Power Supply Input
Voltage

90-280 Vac

Power Supply Input
Frequency

47-63 Hz

Battery Revert 12V (25W radios)
24V (100W, 110W, and 125W radios)

T/R Separation (with
duplexer option)

VHF
>1.5 MHz

UHF
3 MHz

800
45 MHz

900
39 MHz

Temperature Range
(ambient)

– 30 °C to + 60 °C (-22 °F to 140 °F)

A.3.2

Receiver – QUANTAR
The following table lists the receiver performance specifications for the QUANTAR® station:

Table 12: Receiver Performance Specifications – QUANTAR

Item Description

Intermediate Frequen-
cies

VHF
21.45 MHz
(1st)
450 kHz (2nd)

UHF
73.35 MHz
(1st)
450 kHz (2nd)

800
73.35 MHz
(1st)
450 kHz (2nd)

900
73.35 MHz
(1st)
450 kHz (2nd)

Preselector Band-
width

VHF
4 MHz

UHF
4 MHz

800
19 MHz

900
6 MHz

Sensitivity (12 dB SI-
NAD)

VHF
–119 dBm

UHF
–116 dBm

800
–117 dBm

900
–117 dBm

Adjacent Channel Re-
jection

VHF
90 dB (25/30
kHz)
80 dB (12.5
kHz)

UHF
75 dB (12.5
kHz)
85 dB (25 kHz)

800
70 dB (12.5
kHz)
80 dB (25 kHz)

900
70 dB

Intermodulation Re-
jection

VHF
85 dB (25/30
kHz)
80 dB (30 kHz)

UHF
85 dB

800
85 dB

900
70 dB

Spurious and Image
Rejection

100 dB

Wireline Output -20 dBm to 0 dBm @ 60% Rated System Deviation, 1 kHz

Audio Response (An-
alog Mode)

+1, -3 dB from 6 dB per octave de-emphasis; 300-3000 Hz referenced to
1000 Hz at line input

Audio Distortion Less than 3% @ 1000 Hz
Table continued…
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Item Description

FM Hum and Noise
(300 to 3000 kHz
bandwidth)

VHF
50 dB (25/30
kHz)
45 dB (12.5
kHz)

UHF
45 dB (12.5
kHz)
50 dB (25 kHz)

800
45 dB (12.5
kHz)
50 dB (25 kHz)

900
45 dB

Frequency Stability VHF
1 ppm

UHF
1 ppm

800
1 ppm

900
0.1 ppm

RF Input Impedance 50 Ohms

FCC Designation VHF
ABZ89FR3776

UHF
ABZ89FR4796

800
ABZ89FR5757

900
ABZ89FR5768

A.3.3

Transmitter – QUANTAR
The following table lists the transmitter performance specifications for the QUANTAR® station:

Table 13: Transmitter Performance Specifications – QUANTAR

Item Description

Power Output VHF
6-25W
25-125W

UHF
5-25W
25-110W

800
5-20W
20-100W

900
25-100W

Electronic Bandwidth Full sub-band

Intermodulation At-
tenuation

VHF
20 dB

UHF
50 dB

800
50 dB

900
20 dB

Spurious and Har-
monic Emissions At-
tenuation

VHF
90 dB

UHF
90 dB

800
90 dB

900
90 dB

Deviation VHF, UHF, and 800
±5 kHz (25 kHz)
±2.5 kHz (12.5 kHz)
±4 kHz (SECURENET coded)
±2.4 kHz (SECURENET coded)

900
±2.5 kHz

Audio Sensitivity -35 dBm to 0 dBm (variable)

Audio Response (An-
alog Mode)

+1, -3 dB from 6 dB per octave pre-emphasis; 300-3000 Hz referenced to
1000 Hz at line input

Audio Distortion Less than 2% @ 1000 Hz @ 60% rated system devia-
tion

FM Hum and Noise
(300 to 3000 Hz
bandwidth)

45 dB nominal (12.5 kHz)
50 dB nominal (25/30 kHz)

Frequency Stability VHF, UHF, and 800
1 ppm

900
0.1 ppm

RF Output Impedance 50 Ohms
Table continued…
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Item Description

FCC Designation VHF
25W:
ABZ89FC3774
125W:
ABZ89FC3773

UHF
25W:
ABZ89FC4797
110W:
ABZ89FC4798

800
20W:
ABZ89FC5775
100W:
ABZ89FC5776

900
100W:
ABZ89FC5767

A.3.4

G-Series Related Performance Specifications
Performance specifications for the GTR 8000 Base Radio and GTR 8000 Expandable Site Subsystem
have a wide range of values that are dependent on the frequency band and application.

GTR 8000 Base Radio Specifications
The GTR 8000 Base Radio specifications are documented in the GTR 8000 Base Radio manual. The
specific sections in the manual are listed in the following table:

Frequency Section

800 MHz GTR 8000 Base Radio Specifications for Integrated Voice and Data (700
and 800 MHz)

UHF R1 (380–435
MHz)

GTR 8000 Base Radio Specifications for Integrated Voice and Data UHF
R1 (380–435 MHz)

UHF R2 (435–524
MHz)

GTR 8000 Base Radio Specifications for Integrated Voice and Data UHF
R2 (435–524 MHz)

VHF (136–174 MHz) GTR 8000 Base Radio Specifications for Integrated Voice and Data VHF
(136–174 MHz)

GTR 8000 Expandable Site Subsystem Specifications
The GTR 8000 Expandable Site Subsystem specifications are documented in the GTR 8000
Expandable Site Subsystem manual. The specific sections in the manual are listed in the following
table:

Frequency Section

900 MHz Specifications for GTR 8000 Expandable Site Subsystem for Integrated
Voice and Data (900 MHz)

800 MHz Specifications for GTR 8000 Expandable Site Subsystem for Integrated
Voice and Data (700/800 MHz)

UHF R1 (380–435
MHz)

Specifications for GTR 8000 Expandable Site Subsystem for Integrated
Voice and Data (UHF R1, 380–435 MHz)

UHF R2 (435–524
MHz)

Specifications for GTR 8000 Expandable Site Subsystem for Integrated
Voice and Data (UHF R2, 435–524 MHz)

VHF (136–174 MHz) Specifications for GTR 8000 Expandable Site Subsystem for Integrated
Voice and Data (VHF 136–174 MHz)

MN003231A01-A
Appendix A:  Replacement of a Trunked QUANTAR with a GTR 8000 Base Radio

Motorola Solutions Confidential

112  Send Feedback

http://docsurvey.motorolasolutions.com


A.4

Installation Prerequisites and Electrical Connections
This section contains installation precautions and prerequisites, as well as electrical connections of
ports for the QUANTAR® station and the GTR 8000 Base Radio. The base radios contained within the
GTR 800 Expandable Site Subsystem cabinet share the same electrical connections described in this
section. However, all external connections to the GTR 8000 Expandable Site Subsystem cabinet are
made at the junction panel.

A.4.1

Pre-Installation Considerations for the GTR 8000 Base Radio and
the GTR 8000 Expandable Site Subsystem
Part of the pre-installation requirements is to become familiarized with the physical size of the devices
replacing the QUANTAR® station and the structure in which it is installed.

A.4.1.1

Physical Dimensions

The physical size of the standalone GTR 8000 Base Radio differs in comparison to the QUANTAR®

station mostly in height and depth. The width of both is the same. The most noticeable size issue
between the base radio and station is the depth. The GTR 8000 Base Radio is 82 mm (3.23”) longer in
depth than the QUANTAR® station.

The GTR 8000 Expandable Site Subsystem is available with three optional heights.

NOTICE: The recommended clearance for service and installation is at least 2 ft in the front and
rear of the base radio.

Table 14: Base Radio Dimensions

Description QUANTAR station GTR 8000 Base Radio

Size (H x W x
D)

220.5mm x 483mm x 375mm
( 8.68" x 19" x 14.75")

133mm x 483mm x 457mm
( 5.25" x 19" x 18")

Table 15: GTR 8000 Expandable Site Subsystem Dimensions

Description GTR 8000 Expandable Site Subsystem

Height

Cabinet Version (Option CA00293AA):
7.5 ft. Open Rack Version (Option X882AH):
7 ft. Open Rack Version (Option
CA01402AA):

84.8 in. (215 cm) 43 Rack Units
90.4 in. (230 cm) 48 Rack Units
84.3 in. (214 cm) 44 Rack Units

Footprint (W x D)

Cabinet Version (Option CA00293AA):
Open Rack Version (Option X882AH
CA01402AA):

23.6 x 23.6 (60 x 60 cm)
20.5 x 23.5 in. (52 x 60 cm)
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A.4.1.2

Cabinet Replacement
Due to the physical size of the standalone GTR 8000 Base Radio within an existing QUANTAR® station
cabinet, an alternate cabinet may be required. It is the responsibility of the site designer and field
engineer to ensure that the operating environment of the standalone GTR 8000 Base Radio is within its
rated specifications whether within a cabinet or in an open rack. The following recommendations are
intended to serve as guidelines and not as a replacement for proper validation/measurement of the
operating environment and base radio functionality.

A.4.1.2.1
Inside Cabinet Clearance
It is recommended that any cabinet used to house a standalone GTR 8000 Base Radio is at least 600
mm (23.62 in.) deep. The base radio may fit in cabinets as shallow as 490 mm (19.29 in.). However,
care must be taken to center the base radio such that the front fan modules and the rear backplane
cable clearances are maintained from the doors. In cabinets less than 600 mm deep, right angle
adapters on some cables may be necessary, such as the BNC Rx input. The GTR 8000 Base Radio
comes equipped with a right angle line cord.

The clearance from the front and rear of the GTR 8000 Base Radio within existing QUANTAR® station
cabinets is different. This clearance may require the adjustment of cabinet rails or specialized spacers.

A.4.1.2.2
Cabinet Doors
All front and rear doors on cabinets used to house standalone GTR 8000 Base Radios should be
louvered or perforated for ventilation. At a minimum, it is highly recommended that the vents align with
the fans on the base radio. This alignment ensures that an ample airflow is supplied to the fans. In
addition, a 1 in. clearance from a cabinet door to the fans allows for proper air diffusion and transition
into the fans. The backplane of the base radio provides for proper exit space with corner protection
pins. The ventilation of rear doors should also align with each base radio within the cabinet.

A.4.1.2.3
Heat Considerations
When replacing QUANTAR® stations within a cabinet, it is recommended that the same or fewer
numbers of standalone GTR 8000 Base Radios be used. Even though GTR 8000 Base Radios are
smaller in height than QUANTAR® stations, adding additional base radios can significantly increase the
airflow requirements and total heat in the cabinet. The heat from additional base radios can result in
thermal performance issues. It is also recommended to place blank panels in any extra spaces left in
the cabinet. The extra panels prevent air recirculation from occurring which can cause a significant
thermal rise within the cabinet.

A.4.2

Electrical Connections and Pinouts
This section describes the differences in electrical connections between the QUANTAR® station and
the GTR 8000 Base Radio. It provides pinout cross-references for all relevant connection ports, as well
as simple circuit schematics.

The base radios contained within the GTR 800 Expandable Site System share electrical connections
described in this section. However, all external connections to the GTR 8000 Expandable Site
Subsystem are made at the junction panel. See GTR 8000 Expandable Site Subsystem Junction Panel
Connections on page 117 for details.
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A.4.2.1

Power Requirements
The power requirements for the QUANTAR® station, GTR 8000 Expandable Site Subsystem, and GTR
8000 Base Radio are identical. The power cord used for the QUANTAR® station can be reused to
connect the GTR 8000 Base Radio to the power source. The GTR 8000 Expandable Site Subsystem
uses a power distribution module near the junction panel for customer-provided AC and DC inputs. The
following table lists the power requirements for each base radio:

Table 16: Power Requirements

Port QUANTAR

GTR 8000 Base Radio
GTR 8000 Expandable Site Subsystem

AC Input 120V/240 VAC 120V/240 VAC

DC/Batt 12, 24, 48, or 60 VDC 48 VDC

NOTICE: If a DC power source is used, the DC power source must be 48 VDC for the GTR
8000 Base Radio and GTR 8000 Expandable Site Subsystem.

A.4.2.2

External Frequency Reference
The external frequency connection (5 MHz Input) on the QUANTAR® station can be made at the
Station Control Module (Front) or at connector # 30 (Backplane). An EXT FREQ REF input for the
standalone GTR 8000 Base Radio is on the backplane when the ASTRO® 25 repeater site has more
than six standalone GTR 8000 Base Radios, or has a mixture of more than six standalone GTR 8000
Base Radios and QUANTAR® stations.

NOTICE: An external termination is required to properly terminate the cable connected to the
input. Motorola Solutions recommends connecting the BNC "T" and a 50 Ohm BNC termination
to the input.

Table 17: External Frequency Reference

Base Radio Port / Type Description

QUANTAR® Station Station Control Module /
BNC

Connector #30 (5 MHz In-
put) / BNC

Accepts an external 5 MHz frequency for
calibrating the station reference oscillator,
located in the Station Control Module.

Station Control Module: 1.0 ± 0.5 V
RMS @ 50 ohms

Connector #30: 2.5 V P-P minimum @
150 kohms (High Impedance)

GTR 8000 Base Radio EXT FREQ REF / BNC The back port accepts a composite (5
MHz + 1PPS), 5 MHz (square or sine
wave) or 10 MHz (square or sine wave)
external site reference signal to drive the
internal oscillator for precise frequency
stability. It also provides an accurate time
source used for precisely launching si-
mulcast data over the air.
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Base Radio Port / Type Description

See GTR 8000 Base Radio Time and
Frequency Input for detailed specifica-
tions.

NOTICE: The Frequency Ref-
erence is configured on the
Hardware Configuration win-
dow in CSS.
If a composite frequency refer-
ence source is used, the Time
Reference parameter must be
selected as Combined with Fre-
quency Reference.

A.4.2.3

GTR 8000 Base Radio Frequency Inputs
Various external frequency inputs can be provided to the GTR 8000 Base Radio for normal operation
or for Internal Frequency Reference Oscillator alignment. The following table provides a list of
acceptable input signal types and levels for each base radio input port:

Table 18: Base Radio Time and Frequency Inputs

Input Port
Frequen-

cy
Wave-
form

Level Impedance Note

EXT FREQ REF 5 MHz Sine 2.6-5.3Vpp 100 kohms AC coupled

EXT FREQ REF 5 MHz Square — 100 kohms AC coupled
45-55% duty cy-
cle

EXT FREQ REF 10 MHz Sine 2.6-5.3Vpp 100 kohms AC coupled

EXT FREQ REF 10 MHz Square — 100 kohms AC coupled
45-55% duty cy-
cle

EXT FREQ REF 20 MHz Sine 2.6-5.3Vpp 100 kohms AC coupled

EXT FREQ REF 20 MHz Square — 100 kohms AC coupled
45-55% duty cy-
cle

EXT FREQ REF 5 MHz/
1PPS

Square 2.6-5.3Vpp 100 kohms AC coupled; 25%
modulation
1pps arrives on
75% duty cycle

Front Panel EXT
FREQ REF

5 MHz Sine 2-5Vpp;
10-18 dBm

50 ohms AC coupled

Front Panel EXT
FREQ REF

5 MHz Square — 50 ohms AC coupled
45-55% duty cy-
cle

Table continued…
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Input Port
Frequen-

cy
Wave-
form

Level Impedance Note

Front Panel EXT
FREQ REF

10 MHz Sine 2-5Vpp;
10-18 dBm

50 ohms AC coupled

Front Panel EXT
FREQ REF

10 MHz Square — 50 ohms AC coupled
45-55% duty cy-
cle

NOTICE: The Front Panel EXT FREQ REF connection is the Frequency Calibrator (BNC
connector) on the transceiver module.

A.4.2.4

Standalone GTR 8000 Base Radio Connections
The connections to the standalone GTR 8000 Base Radio are made to the front and rear connections.
See the Installation chapter, “GTR 8000 Base Radio Rear Connections (Integrated Voice and Data)”
and “GTR 8000 Base Radio Front Connections” in the GTR 8000 Base Radio manual.

A.4.2.5

GTR 8000 Expandable Site Subsystem Junction Panel Connections
The connections to the GTR 8000 Expandable Site Subsystem are made at the junction panel. The
junction panel configurations are dependent on the frequency. See the Installation chapter, “Junction
Panel Connections for an ASTRO 25 Repeater Site (700/800/900 MHz and UHF R2 435–524 MHz)” or
“Junction Panel Connections for an ASTRO 25 Repeater Site (UHF R1 380–435 MHz MHz, 800 MHz
High-Power, and VHF 136–174 MHz)” in the GTR 8000 Expandable Site Subsystem manual.

A.5

Replacement of a QUANTAR Station with a Standalone GTR
8000 Base Radio or GTR 8000 Expandable Site Subsystem
The GTR 8000 Base Radio provides the same site connections that are available on a QUANTAR®

station. These include AC power, external frequency reference, and Rx/Tx antennas, 10BaseT
Ethernet connection, and CSS service and configuration. However, there is a difference in the DC
voltage backup requirements. The GTR 8000 Base Radio only uses a 48 VDC power source while the
QUANTAR® station supports a 12 VDC, 24 VDC, 48 VDC, or 60 VDC power source, depending on the
installed power supply.

The junction panel for the GTR 8000 Expandable Site Subsystem provides all the connections from an
ASTRO® 25 repeater site. The junction panel includes connections for trunking controls, voice and
audio connections, and Rx/Tx antennas. The different connections are provided through sub-panels
installed on the junction panel. The sub-panel configurations on the junction panel depend on the
frequency band. See the Installation chapter, “Junction Panel Connections for an ASTRO 25 Repeater
Site (700/800/900 MHz and UHF R2 435–524 MHz)” and “Junction Panel Connections for an ASTRO
25 Repeater Site (UHF R1 380–435 MHz, 800 MHz High-Power, and VHF 136–174 MHz)” in the GTR
8000 Expandable Site Subsystem manual for details.

NOTICE: A minimum of two channels must occupy a primary cabinet.

The CSS supports service and configuration of the GTR 8000 Base Radios and provides the same
configuration screens used with the QUANTAR® station.
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A.5.1

Replacing a QUANTAR Station
This section outlines the process of replacing a QUANTAR® station with a standalone GTR 8000 Base
Radio or GTR 8000 Expandable Site Subsystem.

Process:

1 Archive the current codeplug for the QUANTAR® station using the Customer/Service Software
(CSS). See Archiving the QUANTAR Codeplug in CSS on page 118 for details.

2 Power down and remove the QUANTAR® station from the site. See Powering Down and
Removing the QUANTAR Station on page 119 for details.

3 Optional: Install HP LAN switches to provide network management to the channels. See Adding
an HP2620-24 LAN Switch to an ASTRO 25 Repeater Site on page 79.

4 Install the standalone GTR 8000 Base Radio into the station rack or cabinet, or install the GTR
8000 Expandable Site Subsystem. See Installing a GTR 8000 Base Radio on page 122 or 
Installing a GTR 8000 Expandable Site Subsystem on page 124.

5 Configure the GTR 8000 Base Radio using the CSS software. See Configuring the GTR 8000
Base Radio in CSS on page 128 for details.

A.5.1.1

Archiving the QUANTAR Codeplug in CSS
Prerequisites: Wear an Electrostatic Discharge (ESD) strap and connect its cable to a verified good
ground. This strap must be worn throughout this procedure to prevent ESD damage to any
components.
The following cable hardware and software application are required:

• Ethernet cable

• Configuration/Service Software (CSS)

When and where to use: This procedure describes how to read the current codeplug from the
QUANTAR® station and save the codeplug as a codeplug report text file or as an archive file. The
codeplug is used as reference when configuring the GTR 8000 Base Radio.

Procedure:

1 Connect to the station using CSS. See Connecting Through an Ethernet Port Link on page 87.

2 Save the station configuration to the service computer/laptop as follows:

a From the menu, select File → Read Configuration From Device.

b At the confirmation screen, click OK.

c When the Progress Monitor screen is complete, click OK.

d From the menu, select File → Save As.

e On the Properties Screen, enter the IP address of the station. Click OK.

f On the Save window, select the directory where you want to save the configuration file, type
a meaningful name for the file (use .cpl as the extension or do not type an extension). Press
ENTER.

The station configuration is saved to the location indicated. Use it as a reference later to
configure the replacement GTR 8000 Base Radio.

3 Disable the station:

a From the menu, select Service → Status Panel Screen
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b In the Status Panel Display window, click Disable Channel.

The station is disabled.

4 Close the CSS program.

5 Disconnect the Ethernet cable from the station control module.

A.5.1.2

Powering Down and Removing the QUANTAR Station
When and where to use: This procedure describes the proper sequence for powering down the
QUANTAR® station before disconnecting it and removing it from the site. The channel and any traffic
on the station are lost when the QUANTAR® station is powered down.

WARNING: Shock hazard. The QUANTAR® station contains dangerous voltages which can
cause electrical shock or damage equipment. Turn off the station and disconnect the power
cabling when servicing this equipment. Allow the station to cool before disconnecting any
cables. Exposed surfaces of the unit may be hot.

Procedure:

1 Power down the QUANTAR® station.

a Set the rocker or toggle switch, on the front panel of the power supply module, to the OFF
position.

b Disconnect the power cable from the power source and AC input connection.

c Disconnect the cable from the DC input connection if the station includes a battery backup or
is powered from a DC source.

2 Label and disconnect the following cables that are connected to the ports on the backplane:

• GND (from both backplane and bus bar)

• Ethernet cable from LAN port

• BNC 5 MHz cable

• Power Supply cable (port 25)

• TX and RX cables

3 Reduce the weight load of the repeater by removing the FRU modules from the card cage. See 
Remove the QUANTAR FRU Modules on page 120.

4 Cut all tie wraps that are attached to the station.
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5 Remove the QUANTAR® station from the rack or cabinet.

CAUTION: When removing the QUANTAR® station from a cabinet enclosure or rack, use
the National Institute of Occupational Safety and Health (NIOSH) lifting equation to
determine whether a one or two person lift is required when a system component must
be removed and replaced in a cabinet enclosure or rack.

a Remove the four M6 screws, from the front of the QUANTAR® station, using a T27 bit driver.

b Remove the card cage from the front of the rack or cabinet by sliding it towards you until it
clears the rack.

6 Optional: If installed in a rack, remove the standoff brackets used to hold the QUANTAR®

station.

A.5.1.2.1
Remove the QUANTAR FRU Modules
The following FRU modules should be removed prior to attempting to remove the card cage of the
QUANTAR® from the rack:

• Station Control Module

• Exciter Module

• Receiver Module

• Power Amplifier Module

• Power Supply Module

A.5.1.2.1.1
Removing the Station Control Module

Procedure:

1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.
This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Remove the station control module:

a Remove the two screws securing the faceplate of the station control module.

b Partially slide the faceplate out until the extractor tab is visible on the rear bottom rail of the
faceplate.
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c Slide the faceplate to the left, then tilt the faceplate down to extract the station control board
as shown in the figure.

Figure 37: Removing the Station Control Module

d Pull out the faceplate.

e Slide the station control module from the chassis.

A.5.1.2.1.2
Removing the Exciter Module

Procedure:

1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.
This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Remove the exciter module:

a Disconnect the cable on the upper front of the exciter module.

b Remove the two screws securing the faceplate of the exciter module.

c Slide the exciter module from the chassis.

A.5.1.2.1.3
Removing the Receiver Module

Procedure:

1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.
This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Remove the receiver module:

a Remove the two screws securing the faceplate of the receiver module.

b Slide the receiver module from the chassis.

A.5.1.2.1.4
Removing the Power Amplifier Module

Procedure:

1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.
This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Disconnect the cable from the front of the power amplifier module.

3 Remove the power amplifier module:
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a Remove the two screws securing the faceplate of the power amplifier module.

b Slide the power amplifier module out to the first stop.

c Disconnect the N-type connector from the lower left side of the module.

d Slide the power amplifier module out of the chassis.

A.5.1.2.1.5
Removing the Power Supply Module

Procedure:

1 Wear an electrostatic discharge (ESD) strap and connect its cable to a verified good ground.
This strap must be worn throughout this procedure to prevent ESD damage to any components.

2 Remove the power supply module:

a Remove the two screws securing the faceplate of the power supply module.

b Slide the power supply module out of the chassis.

A.5.1.3

Installing a GTR 8000 Base Radio
Figure 38: GTR 8000 Base Radio – Rear
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Figure 39: GTR 8000 Base Radio – Front with Transceiver Option Card

Procedure:

1 Insert the GTR 8000 Base Radio into the rack and secure it with the four M6 screws using a T27
bit. Torque to 42 in-lbs.

NOTICE: If standoff brackets were used with the QUANTAR® station, install new standoff
brackets for the GTR 8000 Base Radio.

2 Attach the ground cable for the GTR 8000 Base Radio to the grounding bus bar using grounding
screw.

3 Make the following power connections on the backplane of the GTR 8000 Base Radio:

a For DC: Connect the power cable from the BATT/DC port to the circuit breaker or to the
power source at the site.

b For AC: Connect the power cable from the AC IN port to the appropriate wall outlet.

c For Battery Backup: QUANTAR® station battery revert voltage (28 V) is not compatible with
GTR 8000 Base Radio battery revert. The voltages are different and must not be connected.
A 48 V battery for the GTR 8000 Base Radio must be used instead. For AC/DC battery
revert, use both the AC (supplied) and DC power cables.

d For Battery Temperature: Connect the battery temperature sensor cable to the BATT
TEMP port.

4 Connect the cable from the GCP 8000 Site Controller or external LAN switch to the SITE CTRL
A and SITE CTRL B ports on the backplane of the GTR 8000 Base Radio and place an RFI
suppressor onto the Ethernet cable.

5 Connect the receive input cable to the RxA port (BNC connector) on the backplane of the GTR
8000 Base Radio.

• If a preselector is used, connect the N-type cable, removed from the QUANTAR® station, to
the input port on the preselector.

• If no preselector is used, connect a BNC Male to N-Female adapter to the receive cable and
connect the cable to the RxA port.

6 Connect the transmit antenna cable to the Transmit Line port on the backplane of the GTR
8000 Base Radio.

7 Connect the BNC composite 5 MHz/1PPS cable, if present, to the EXT FREQ REF port on the
backplane of the GTR 8000 Base Radio.

MN003231A01-A
Appendix A:  Replacement of a Trunked QUANTAR with a GTR 8000 Base Radio

Motorola Solutions Confidential

Send Feedback   123

http://docsurvey.motorolasolutions.com


8 Power up the GTR 8000 Base Radio by toggling the power switch on the power supply module.

A.5.1.4

Installing a GTR 8000 Expandable Site Subsystem
For detailed connections, see the GTR 8000 Expandable Site Subsystem manual.

Figure 40: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for an
ASTRO 25 Repeater Site (700/800/900 MHz and UHF R2 435–524 MHz)
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Figure 41: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
an ASTRO 25 Repeater Site (700/800/900/UHF R2 435–524 MHz)
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Figure 42: Junction Panel for the GTR 8000 Expandable Site Subsystem Prime Cabinet for an
ASTRO 25 Repeater Site (UHF R1 380–435 MHz, 800 MHz High-Power, and VHF 136–174 MHz)
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Figure 43: Junction Panel for the GTR 8000 Expandable Site Subsystem Expansion Cabinet for
an ASTRO 25 Repeater Site (UHF R1 380–435 MHz, 800 MHz High-Power, and VHF 136–174 MHz)
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Procedure:

1 Install the GTR 8000 Expandable Site Subsystem cabinets/racks in the ASTRO® 25 repeater
site. See the GTR 8000 Expandable Site Subsystem manual for additional installation
requirements and for expansion cabinets/racks connections.

2 Ground the GTR 8000 Expandable Site Subsystem.

IMPORTANT: See the Motorola Solutions Standards and Guidelines for Communication
Sites manual for detailed information about grounding and lightning protection.

3 Make the following power connections:

NOTICE: For proper connections and precautions, see section, “Connecting Power” in
the GTR 8000 Expandable Site Subsystem manual.

a For DC: Connect the DC input feed in the power distribution unit of the GTR 8000
Expandable Site Subsystem.

b For AC: Connect the AC lines through the two knockouts provided on the power distribution
unit of the GTR 8000 Expandable Site Subsystem. A terminal block is provided in the power
distribution unit for termination of the wires. Each base radio must have a dedicated AC line.

c For Battery Backup: QUANTAR® station battery revert voltage (28 V) is not compatible with
GTR 8000 Base Radio battery revert. The voltages are different and must not be connected.
A 48 V battery for the GTR 8000 Base Radio must be used instead.

d For Battery Temperature: Connect the battery temperature sensor cable.

4 Connect the receive input cable on the Receive Input sub-panel of the GTR 8000 Expandable
Site Subsystem.
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a For 800/900 MHz and UHF R2: Connect the receive input cable to Branch A (N-type
connector) on the Receive Input sub-panel.

b For UHF R1 and VHF: Connect the receive input cable to each corresponding receive
connection (RX ‘1’ to RX ‘6’) on the Receive Input sub-panel. Reusing receive cables from a
QUANTAR® station requires the installation of a BNC to N-type connector adapter.

5 Connect the transmit output cable on the Transmit Output sub-panel of the GTR 8000
Expandable Site Subsystem.

a For 800/900 MHz and UHF R2: Connect the transmit antenna cable to TX (N-type or 7/16
type connector) on the Transmit Output sub-panel.

b For UHF R1 and VHF: Connect a transmit antenna cable to each corresponding transmit
connection (TX ‘1’ to TX ‘6’) on the Transmit Output sub-panel.

6 Connect the site router or gateway connection, if connecting directly, to the Gateway
connections on the Primary sub-panel of the GTR 8000 Expandable Site Subsystem.

7 Connect the site LAN connection, if connecting directly, to the Network AUX connections on the
Primary sub-panel of the GTR 8000 Expandable Site Subsystem. Place an RFI suppressor onto
the LAN Ethernet cable.

8 Connect external QUANTAR® stations, if less than six and connecting directly, to the Cab #1 to
Cab #5 connections on the Expansion sub-panel of the GTR 8000 Expandable Site Subsystem.

9 Connect an external GCP 8000 Site Controller, if connecting directly, to the Expansion Input A
and B connections on the expansion cabinet of the GTR 8000 Expandable Site Subsystem.

10 Power up the GTR 8000 Expandable Site Subsystem.

A.5.1.5

Configuring the GTR 8000 Base Radio in CSS
Prerequisites: This procedure requires the following hardware and software:

• Standard or crossover RJ-45 Ethernet cable

• A PC with the Configuration/Service Software (CSS)

When and where to use: This procedure describes the proper steps for configuring the GTR 8000
Base Radio. If possible, the initial configuration of the GTR 8000 Base Radio is performed ahead of
time.

Procedure:

1 Launch the Configuration/Service Software (CSS) application.

2 Connect to the transceiver module Ethernet service port using CSS. See Connecting Through
an Ethernet Port Link on page 87.

3 Configure the GTR 8000 Base Radio using a print out of the Codeplug report archived in the 
Archiving the QUANTAR Codeplug in CSS on page 118 procedure and use it as a reference to
configure the GTR 8000 Base Radio.

4 Set the relevant parameters in the CSS screens to match the values from the QUANTAR®

station codeplug.

NOTICE: For an ASTRO® 25 repeater base radio, see the “Trunking Site – Repeater
Site” section in CSS Online Help.

5 Read the base radio, as follows:

a From the menu, select File → Read Configuration From Device.

b On the confirmation screen, click OK.
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c When the Progress Monitor screen is complete, click OK.

6 Place the base radio in Normal Mode, as follows:

a From the menu, select Service → Test and Measurement Screen.

The Test and Measurement Screen appears.

b Click Change to Normal Mode.

c At the confirmation screen, click OK.

The base radio halts activity in the current mode and switches operation to the requested
mode.

7 Open the Software Download Manager and perform a site download and installation.

8 From the menu, select File → Save As to save the new configuration file.

9 From the menu, select File → Write Configuration To Device to write the configuration to the
base radio.

10 Close the CSS application and disconnect the PC.

A.6

Alignment and Equalization Procedures
The following alignment and equalization procedures should be performed on the GTR 8000 Base
Radio in the order in which they are listed:

• Reference Oscillator Alignment

• Tx Wireline Alignment

• Rx Wireline Alignment

• Carrier Squelch Alignment

• Battery Equalization

WARNING: To guard against personal injury and/or damage to equipment, switch the base
radio to Service Mode when performing service. Transmit inhibiting the base radio within the
Station Status screen in the CSS also prevents the transmitter from keying. Remember to
switch the base radio back to Normal Mode when service is complete.

All alignment and equalization procedures are performed using the CSS service Alignment screens.
See the following CSS Online Help contents selection for detailed procedures:

Base Radio Service Help → Service Screens → Alignment Screens

Expand the relevant Alignment Screen tab from the trunked GTR 8000 section, for example, Reference
Oscillator Alignment Tab, and click the procedure link.

In addition, various procedures should also be performed to tune RFDS devices and to verify receiver
and transmitter performance. See the GTR 8000 Expandable Site Subsystem and GTR 8000 Base
Radio manual for detailed procedures.
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